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ΕΙΣΑΓΩΓΗ 
 

GBML – Rule Based Machine Learning 
 
   Τα GBML συστήµατα των οποίων πατέρας θεωρείται ο Holland είναι συστήµατα 

εκµάθησης κανόνων και κατηγοριοποίησης (Classifier Systems). Βασίζονται σε 

σύνολα κανόνων (rule-sets) που συνήθως βρίσκονται στην µορφή “IF state THEN 

action”  και  εκπαιδευόµενα µέσω γενετικών αλγορίθµων και εξελικτικών τεχνικών 

έχουν την ικανότητα αξιολόγησης και εξέλιξης της γνώσης που βρίσκεται µέσα σε 

αυτούς τους κανόνες και την περιγράφουν µε τρόπο «πλήρη» και «περιεκτικό».  

Αναφέρονται σε προβλήµατα για την λύση των οποίων απαιτείται λογισµικό που να 

έχει την ικανότητα προσαρµογής, δηλαδή να παρουσιάζει προσαρµοστικότητα. 

Προβλήµατα των οποίων οι λύσεις έχουν άµεση συνάρτηση  µε τον περιβάλλοντα 

χώρο και τις ειδικές συνθήκες που επικρατούν σ’ αυτόν. Μπορούν να 

προσοµοιώσουν συστήµατα εισόδου-εξόδου µε την εκµάθηση των κανόνων και της 

εξέλιξης αυτών µέσα από έναν ΓΑ για την απόκριση της επιθυµητής συµπεριφοράς 

εισόδου-εξόδου. Θα πρέπει να αναφέρουµε επίσης ότι τα GBML συστήµατα 

προσεγγίζουν τον χώρο της Τεχνητής Ευφυΐας και αποµακρύνονται από τον χώρο της 

βελτιστοποίησης. 

   Όσον αφορά τις εξελικτικές τεχνικές, αφοµοιώνονται µηχανισµοί και διαδικασίες 

που βασίζονται στην θεωρία που διατυπώθηκε από τον ∆αρβίνο [1859] περί της 

εξέλιξης των ειδών. Οι τεχνικές αυτές εµπεριέχουν κάποιες αξιοσηµείωτες ιδιότητες 

όπως παράλληλη επεξεργασία/υλοποίηση που παρέχει την δυνατότητα της 

ταυτόχρονης αξιολόγησης των λύσεων, προσαρµοστικότητα των προτεινόµενων 

λύσεων, διαδικασίες τροποποίησης των λύσεων και αλληλεπίδρασης µεταξύ τους και 

επιλογής των πιο βέλτιστων κάθε φορά λύσεων εντός µιας γενιάς ώστε να παραχθεί η 

επόµενη µέσα από χρήση γενετικών τελεστών. 

   Παρακάτω θα αναπτύξουµε τις αρχές που διέπουν τα Classifier Systems και θα τις 

εφαρµόσουµε σε µια υλοποίηση για την εύρεση του βέλτιστου σετ κανόνων για την 

περιγραφή ενός απλού ψηφιακού πολυπλέκτη 4 σε 1 και  8 σε 1.  

   Επίσης θα αναπτυχθεί και σύνθετο µοντέλο µε δυνάµεις κανόνων και αλγόριθµο 

απονοµής βαθµών (Bucket Brigade Algorithm) εφαρµόζοντας το σε απλό πρόβληµα 
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κατηγοριοποίησης (classification) αυξάνοντας την πολυπλοκότητα του και συνάµα  

αποτελώντας µια πιο επιθυµητή ρεαλιστική συµπεριφορά.  
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CLASSIFIER SYSTEMS  
 

Τι είναι ένα Classifier System και από τι αποτελείται  
 
   Ένα Classifier System είναι ένα σύστηµα εκµάθησης και κατηγοριοποίησης 

συντακτικά απλών αλφαριθµητικών κανόνων (rules ή classifiers)  µε γενικό 

µηχανισµό για την παράλληλη επεξεργασία των κανόνων, για την αξιολόγηση της 

αποδοτικότητας των κανόνων και την προσαρµοστική παραγωγή νέων πιο βέλτιστων. 

   Έτσι ένα Classifier System αποτελείται από τρία κύρια µέρη: 

 
1. Κανόνες-Μηνύµατα (Rule and Message System) 

2. Σύστηµα καταµερισµού Βαθµών (Apportionment of credit system) 

3. Γενετικό αλγόριθµο (Genetic Algorithm)  

    
   Πολλά παραδοσιακά συστήµατα Τεχνητής Ευφυΐας χρησιµοποιούν σειριακή 

ενεργοποίηση των κανόνων. Αυτή η από κανόνα σε κανόνα διαδικασία  δεν βοηθάει 

στην αύξηση της αποδοτικότητας  και πολλές διαφορές µεταξύ τέτοιων συστηµάτων 

αφορούν στην στρατηγική της επιλογή ενός µόνο  “βέλτιστου” απλού ενεργοποιηµέ- 

νου κανόνα. Τα Classifier συστήµατα υπερπηδούν την κατάσταση αυτή µε την 

δυνατότητα της παράλληλης ενεργοποίησης πολλών κανόνων ταυτόχρονα κατά την 

διάρκεια ενός κύκλου. 

   

   Στο σχήµα 1 παρουσιάζεται η όλη διαδικασία που λαµβάνει χώρα σε ένα σύστηµα 

εκµάθησης κανόνων - Classifier System. 
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Κανόνες-Μηνύµατα (Rule and Message System) 
 
   Το σύστηµα των κανόνων και µηνυµάτων είναι ένα σύστηµα που προσοµοιώνει ένα 

σύστηµα εισόδου-εξόδου. Οι κανόνες αυτοί είναι της µορφής: 

                                     Εάν <συνθήκη> τότε <ενέργεια> 

   Αυτό σηµαίνει πως όταν επαληθευτεί η συνθήκη (condition) τότε παράγεται η 

αντίστοιχη ενέργεια (action). Μια πιο προσδιοριστική µορφή ενός Classifier είναι η 

εξής: 

< classifier> ::= < συνθήκη > : <µήνυµα> 

όπου το µήνυµα (action) είναι µια συµβολοσειρά σταθερού µήκους και 

κωδικοποιείται από το αλφάβητο {0,1}L, δηλαδή µια αλληλουχία L χαρακτήρων από 

0 και 1. 

   Η συνθήκη (condition) ενός κανόνα είναι και αυτή σταθερού µήκους µόνο που εδώ 

πρέπει να προστεθεί στο παραπάνω αλφάβητο ο χαρακτήρας “#” (wildcard character 

ή don’t care symbol) που λειτουργεί είτε µε την τιµή 0 είτε µε την τιµή 1. Παράδειγµα 

ενός classifier µε 4 bits  για condition και action είναι το: 

##00 : 0001 
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που ενεργοποιείται από το µήνυµα 1100 αλλά όχι από το 1110 και παράγει το µήνυµα 

0001. 

   Αυτό που συµβαίνει σε ένα σύστηµα κανόνων και µηνυµάτων είναι πως η πληρο- 

φορία που απορρέει από το περιβάλλον λαµβάνεται διαµέσου των detectors, που είναι 

τα αισθητήρια όργανα  – τα αυτιά και τα µάτια ενός Classifier συστήµατος –  και την 

κωδικοποιούν σε ένα µήνυµα πεπερασµένου µεγέθους. Τα µηνύµατα αυτά 

αποστέλλονται σε µια πεπερασµένη λίστα µηνυµάτων (message list) και µπορούν να 

διεγείρουν έναν ή περισσότερους κανόνες. Με την διέγερση των κανόνων παράγονται  

µηνύµατα που και αυτά µπορούν να ενεργοποιήσουν άλλους κανόνες µέχρι αυτή η 

διαδικασία να σταµατήσει µε την απόκριση του συστήµατος µέσω των effectors.  

   Με τα όσα ειπώθηκαν µέχρι τώρα δηµιουργούνται κάποιες απορίες όπως όταν η 

λίστα µηνυµάτων είναι ανεπαρκούς µεγέθους για να αποθηκεύσει όλους τους κανόνες 

που “ταιριάξανε” µε τα µηνύµατα, πως καθορίζεται ποιοι από αυτούς θα 

ενεργοποιηθούν; Η απάντηση για το ερώτηµα αυτό όπως και άλλες προσοµοιάζουσες 

συνδέονται µε το σύστηµα καταµερισµού βαθµών (Apportionment of credit system) η 

οποία εφαρµόζει µία «οικονοµία» ανταγωνιστικού είδους, που προκρίνει τους 

καλύτερους και η οποία θα αναπτυχθεί αµέσως µετά. 

   Ακολουθεί ένα παράδειγµα για να κατανοηθεί καλύτερα το σύστηµα κανόνων και 

µηνυµάτων. Έστω το ακόλουθο σύστηµα κανόνων και µηνυµάτων:  

          

Classifier
 

1)                 01## : 0000 
2)                        00#0 : 1100 
3)                      11## : 1000 
4)                ##00 : 0001 

 
 

    

 

   Αρχικά εµφανίζεται  σαν είσοδος στην λίστα µηνυµάτων το µήνυµα 0111 

(περιβάλλον). Ενεργοποιείται ο κανόνας 1 και παράγεται το µήνυµα 0000. Αυτό µε 

την σειρά του ενεργοποιεί ταυτόχρονα τους κανόνες 2 και 4 και παράγονται τα 

µηνύµατα 1100 και 0001 αντίστοιχα. Το 0001 δεν ενεργοποιεί κανέναν κανόνα. Το 

1100 ενεργοποιεί τους κανόνες 3 και 4 και παράγονται τα µηνύµατα 1000 και 0001 

αντίστοιχα. Το 1000 ενεργοποιεί τον κανόνα 4 που παράγει το µήνυµα 0001 και η 

διαδικασία σταµατά αφού το τελευταίο µήνυµα δεν ενεργοποιεί κανέναν κανόνα. 
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Σύστηµα Καταµερισµού Βαθµών (Apportionment of 

credit system) 

 
   Καθώς το µήνυµα ταιριάζει µε πολλούς κανόνες είναι απαραίτητο να δούµε ποιοι 

από αυτούς θα ενεργοποιηθούν καθώς η λίστα µηνυµάτων είναι πεπερασµένη. Έτσι 

κάθε κανόνας έχει ένα βαθµό «δύναµης» S (Strength) µέσω του οποίου καθορίζεται 

ποιος κανόνας θα ενεργοποιηθεί.  

   Για την δυναµική αξιολόγηση των κανόνων έχουν προταθεί πολλοί τρόποι. Εµείς 

θα  χρησιµοποιήσουµε τoν πιο διαδεδοµένο, αυτόν που ο Holland ονόµασε “bucket 

brigade algorithm”.  

   Σύµφωνα µε τον αλγόριθµο αυτόν όταν ένας κανόνας ταιριάξει µε ένα µήνυµα δεν 

ενεργοποιείται κατευθείαν αλλά γίνεται υποψήφιος προς ενεργοποίηση. Για να 

επιλεγεί ένας κανόνας ώστε να ενεργοποιηθεί προσφέρει ένα ποσό ανάλογο της 

σχετικής του δύναµης Β (Bid). Το ποσό αυτό, αποτελεί «πληρωµή» P (payment) και 

µοιράζεται σε όλους τους κανόνες που παρήγαγαν τα µηνύµατα τους και 

ενεργοποίησαν τον κανόνα. Οι κανόνες λοιπόν συµµετέχουν σε µια «οικονοµία της 

πληροφορίας» όπου η δυνατότητα του να δίνεις και να λαµβάνεις πληροφορία 

αγοράζεται και πουλιέται. Αυτό γίνεται µε 2 µηχανισµούς που αποτελούν τα µέρη του 

Bucket Brigade: 

1. Την «∆ηµοπρασία» (Auction), κάθε κανόνας συναγωνίζεται µε τους άλλους 

για να ενεργοποιηθεί. 

2. και την «Πληρωµή Επιταγών», κάθε κανόνας προσφέρει σε αυτούς που τον 

ενεργοποίησαν      

   Προκύπτουν λοιπόν κάποια συµπεράσµατα. Κανόνες µε µεγάλη δύναµη έχουν 

µεγαλύτερη πιθανότητα να ενεργοποιηθούν πράγµα που δείχνει την σπουδαιότητα 

του κάθε κανόνα. Ακόµη το µοίρασµα του πόσου που προσφέρεται από τους κανόνες 

συµβάλλει στο να δηµιουργούνται οµάδες κανόνων που δείχνουν την αναζητούµενη 

συµπεριφορά όπως συµβαίνει και µε το “fitness sharing”, µόνο που εδώ η µέθοδος 

αυτή µετακινεί άτοµα από περιοχές µε ανεξέλεγκτα συσσωρευµένα άτοµα-λύσεις 

(κανόνες) σε περιοχές υπο-βέλτιστων λύσεων όπου δηµιουργούν υπο-πληθυσµούς.   

   Για να κατανοηθούν ακόµη περισσότερο τα όσα αναφέρθηκαν θα ξαναειπωθεί το 

παράδειγµα που αναφέρθηκε στην προηγούµενη παράγραφο εφαρµόζοντας σ’ αυτό 

τον ΒΒ (Bucket Brigade). 
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   Αρχικά η δύναµη του κάθε κανόνα θα έχει την τιµή 200. Ακόµη το ποσό που θα 

προσφέρεται από τους κανόνες θα είναι ανάλογο της δύναµης τους και θα 

καθορίζεται από έναν συντελεστή Cbid µε τιµή 0.1 . Άρα η αρχική προσφορά κάθε 

κανόνα θα είναι Bid = Strength *  Cbid ,  Bid=20. Θα πρέπει επίσης, να ορίσουµε και 

ένας είδος φορολογίας ώστε να µην αυξάνεται υπερβολικά η δύναµη των πιο συχνά 

εµφανιζόµενων κανόνων. Έτσι κάθε ν κύκλους εφαρµόζονται φόροι T (Taxes) στον 

ΒΒ.  

   Κι εδώ το  µήνυµα που έρχεται από το περιβάλλον και λαµβάνεται από τα detectors 

είναι το 0111 (Τα παραδείγµατα αυτά υπάρχουν αυτού καθ΄ αυτού και στις 

σηµειώσεις “Εξελικτική Υπολογιστική” του τµήµατος Πληροφορικής). 

 

 

Πίνακας 1 

   Όπως φαίνεται και στον Πίνακα 1,στον χρόνο 0, το µήνυµα από το περιβάλλον 

0111 διεγείρει τον κανόνα 1 που παράγει το µήνυµα 0000 και προσφέρει 20 µονάδες 

από την δύναµη του στο περιβάλλον επειδή τον ενεργοποίησε. Το 0000 ταιριάζει µε 

τους κανόνες 2 και 4 που παράγουν τα µηνύµατα 1100 και 0001 αντίστοιχα. Από τους 

2 και 4  προσφέρονται 20 µονάδες από τον καθένα στον κανόνα 1. Η προσφορά είναι 

ίδια και από τους δύο κανόνες και παράγονται τα µηνύµατα τους. Το µήνυµα 0001 

του κανόνα  4 δεν ταιριάζει µε κανένα κανόνα . Το 1100 ταιριάζει µε τους 3 και 4 που 

προσφέρουν 20 και 18 µονάδες αντίστοιχα. Ο Οι µονάδες αυτές προσφέρονται στον 2  
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Πίνακας 2 

Παράγονται τα µήνυµα 1000 και 0001. Το 1000 ταιριάζει µε τον κανόνα 4 και που 

προσφέρει 16 µονάδες στον 3. Ο 4 ενεργοποιείται και ο 3 λαµβάνει τις 16 µονάδες 

αλλά το µήνυµα που παράγεται δεν ταιριάζει µε κανέναν κανόνα και η διαδικασία 

σταµατά και το αποτέλεσµα “εκκρίνεται”  δια µέσου των “effectors”. Τέλος η τελική 

προσφορά είναι η ανταµοιβή από το περιβάλλον και δίνεται στον τελευταίο 

ενεργοποιηµένο κανόνα, τον κανόνα 4 (βλέπε και πίνακα 2). 

   Παρόλα αυτά η εκµάθηση ενός Classifier δεν σταµατά εδώ. Μέχρι τώρα είδαµε πως 

δηµιουργούνται οι κανόνες και πως καθορίζονται δυναµικά οι δυνάµεις τους. Πως 

µπορούµε να εισάγουµε όµως καινούργιους κανόνες ώστε να καλυτερέψουµε το 

σύστηµα µας. Την δουλειά αυτή επιτυγχάνει µέσω γενετικής εξέλιξης, η χρήση 

Γενετικού Αλγόριθµου (ΓΑ). 

 

Γενετικός Αλγόριθµος (Genetic Algorithm) 

 
   Την αναζήτηση και εύρεση βέλτιστων λύσεων (κανόνων) καθιστά δυνατή η 

εισαγωγή  γενετικού αλγόριθµου στο σύστηµα. Μέσω της τριµερούς διαδικασίας 

αναπαραγωγή, διασταύρωση, µετάλλαξη ( reproduction, crossover, mutation), οι 

“εξελιγµένοι” κανόνες τοποθετούνται στον πληθυσµό, έτοιµοι να επανακαθορίσουν 

τις δυνάµεις τους µέσα από τον µηχανισµό της δηµοπρασίας της πληρωµής και της 

ενίσχυσης (auction, payment, reinforcement). Ιδιαίτερη προσοχή πρέπει να δοθεί στην 

επιλογή του κανόνα ο οποίος θα αντικατασταθεί µέσα στον πληθυσµό. Στην 

εκµάθηση συστηµάτων ενδιαφερόµαστε να διατηρήσουµε  µια πιο υψηλού επιπέδου 

ελεγχόµενη εκτέλεση της αντικατάστασης του πληθυσµού. Για αυτό στα συστήµατα 

χρησιµοποιούµε: 
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• Αναπαραγωγή Σταθερής Κατάστασης (Steady-State Replacement) 

• ή Αντικατάσταση ενός µέρους του πληθυσµού κατά ένα µικρό ποσοστό 

(Partial Replacement). 

   Στο σηµείο αυτό να αναφέρουµε πως υπάρχει µια παράµετρος στους ΓΑ που 

καλείται Generation Gap (G) και χρησιµοποιείται για να ελέγχει την υπερθετικότητα 

του πληθυσµού. 

   Ο Γενετικός αλγόριθµος λαµβάνει χώρα κάθε µία περίοδο ΤΓΑ που ορίζεται ως ένας 

κύκλος µεταξύ κανόνων και µηνυµάτων και εκλαµβάνει τους κανόνες ως τον 

τρέχοντα πληθυσµό. Η περίοδος αυτή συµπεριφέρεται είτε ντετερµινιστικά –ο ΓΑ 

καλείται κάθε ΤΓΑ κύκλους– , είτε στοχαστικά/τυχαία –ο ΓΑ καλείται πιθανοκρατικά 

κάθε µέσο όρο περιόδων  ΤΓΑ–. 

   Η επιλογή των γονέων γίνεται βάση της δύναµης του κάθε κανόνα, όπως 

αναφέρθηκε στον ΒΒ, και τέλος παράγεται ο απόγονος µέσω των γενετικών 

τελεστών. Θα πρέπει να σηµειωθεί ότι για τον τελεστή «Μετάλλαξης» λαµβάνεται 

υπόψη το τριαδικό αλφάβητο για την συνθήκη (condition) και το δυαδικό για το 

µήνυµα (action). 

   Είναι ιδιαίτερα χρήσιµο οι γενετικοί αλγόριθµοι να  αναλυθούν µε εκτενή τρόπο, γι’ 

αυτό και αφιερώνεται ένα ολόκληρο κεφάλαιο για σχετικά µε το πώς λειτουργούν, τις 

ιδιότητες τους και γιατί δουλεύουν τόσο αποτελεσµατικά.  
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ΓΕΝΕΤΙΚΟΙ ΑΛΓΟΡΙΘΜΟΙ 

 

Γενικά 
 

   Η ανάγκη µοντελοποίησης ενός φαινοµένου είναι σηµαντική γιατί βοηθάει να 

µελετηθεί ένα σύστηµα διεξοδικότερα και να προσοµοιώσει τη δοµή και τη 

λειτουργία του. Μέσα από ένα µοντέλο ο ερευνητής µπορεί να προσοµοιώσει µε 

µαθηµατικές σχέσεις και εξισώσεις ένα σύστηµα. Τα µοντέλα που αναπαριστούν µε 

χρήση µαθηµατικών προτύπων ονοµάζονται µαθηµατικά µοντέλα. Τα µοντέλα αυτά 

αδυνατούν να αναπαραστήσουν πολύπλοκα συστήµατα τα οποία προϋποθέτουν την 

χρήση µη γραµµικών εξισώσεων που είναι δύσκολο να επιλυθούν αναλυτικά. Η 

ραγδαία ανάπτυξη και εξάπλωση των υπολογιστών συνέβαλλε σε µια νέα 

κατεύθυνση για την περιγραφή συστηµάτων µε την ανάπτυξη υπολογιστικών 

µοντέλων. Τα µοντέλα αυτά δεν κάνουν χρήση  µαθηµατικών σχέσεων αλλά 

κατάλληλων υπολογιστικών προγραµµάτων για την λειτουργία του εκάστοτε 

συστήµατος.             

   Παράλληλα η πεποίθηση ότι η αναζήτηση λύσεων για πολύπλοκα υπολογιστικά 

προβλήµατα, στον χώρο της βιολογίας, κατακτά όλο και περισσότερο το ενδιαφέρον 

των επιστηµόνων. Προβλήµατα που προϋποθέτουν την παράλληλη και ταυτόχρονη 

διερεύνηση πολλών υποψήφιων λύσεων ώστε να βρεθεί η πιο βέλτιστη από το 

σύνολο αυτό. Έτσι αναπτύχθηκαν οι εξελικτικοί αλγόριθµοι που παρουσίαζαν έντονη 

γοητεία, αφού η δοµή και η λειτουργία τους εµπνεύσθηκαν από τις αρχές και τους 

µηχανισµούς της εξέλιξης των ειδών και του νόµου της επιβίωσης των καλύτερων 

ατόµων (survival of the fittest) που διέπουν τα φυσικά βιολογικά συστήµατα, όπως 

καθορίσθηκαν από τον ∆αρβίνο. 

   Κύριος και πιο αντιπροσωπευτικός κλάδος των εξελικτικών αλγορίθµων είναι  οι 

γενετικοί αλγόριθµοι που είναι αλγόριθµοι γενικής βελτιστοποίησης (Global 

Optimization Algorithms) και αναζήτησης (Search Algorithms). Αυτοί δίνουν τη 

δυνατότητα της παράλληλης και εξαντλητικής διερεύνησης πολλών υποψήφιων 

λύσεων. Σε κάθε λύση αντιστοιχίζεται ένας βαθµός που δείχνει την καταλληλότητα 

της λύσης και αξιολογούνται ανάλογα µε το είδος του προβλήµατος. Οι καλύτερες 

από αυτές έχουν µεγαλύτερη πιθανότητα να συµµετέχουν σε µια διαδικασία 
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παρόµοια µε αυτή της φυσικής επιλογής, έτσι ώστε να µπορέσουν να 

ανασχηµατίσουν σε καινούργιες λύσεις πιθανότατα καλύτερες, τα “γενετικά” 

χαρακτηριστικά τους. Υπάρχει βέβαια και η πιθανότητα να µην είναι τόσο 

ευεργετικές οι καινούργιες λύσεις, αλλά αφοµοιώνοντας την αρχή της επιβίωσης των 

καλύτερων κατευθυνόµαστε κυρίως στην βαθµιαία βελτίωση των λύσεων. Σε αυτό 

συµβάλλει και ο µικρός αλλά όχι µηδαµινός παράγοντας της µετάλλαξης των 

χαρακτηριστικών των λύσεων, που εµπεριέχει τυχαιότητα,  ευελιξία  και οφείλεται 

στις αλλαγές του περιβάλλοντος από εξωτερικούς παράγοντες. Αν επαναλάβουµε την 

διαδικασία για αρκετές γενιές κρατώντας σαν τρέχοντα πληθυσµό των πληθυσµό των 

απογόνων στην αρχή κάθε γενιάς τότε ο αλγόριθµος θα συγκλίνει στις βέλτιστες 

λύσεις. Αυτή η δυναµική της βελτίωσης των λύσεων και της προσαρµογής τους στις 

εκάστοτε αλλαγές του περιβάλλοντος είναι που καθιστούν τους πληθυσµούς 

βιώσιµους και βελτιστοποιήσιµους. 

   Πρωτοπόρος των γενετικών αλγορίθµων θεωρείται ο John Holland, που µε την 

εργασία του “Adaptation in Natural and Artificial Systems” θεµελίωσε τις αρχές των 

ΓΑ και τα πρώτα θεωρήµατα της θεωρίας σχηµάτων (Schema Theorem). Μαζί µε 

τους µαθητές του, προσπάθησαν: 

a) Να προσδιορίσουν τις διαδικασίες που διέπουν τα φυσικά συστήµατα 

b) Να αναπτύξουν υπολογιστικά προγράµµατα για την πραγµατοποίηση 

τεχνητών συστηµάτων που θα αναπαριστούσαν πραγµατικά συστήµατα, και 

θα τα αξιοποιούσαν σε πρακτικές εφαρµογές. 

 

Λειτουργία Γενετικών Αλγορίθµων 

 
   Ένας Γενετικός Αλγόριθµος αποτελείται από τα ακόλουθα στάδια: 

1.   Αρχική παραγωγή πληθυσµού. Ο πληθυσµός αυτός διατηρεί κωδικοποιηµένες  

λύσεις του προβλήµατος. 

2.   Αξιολόγηση των ατόµων-λύσεων. Μέσα από την συνάρτηση ποιότητας (fitness 

quality function) αποτιµάται κάθε άτοµο. Βάση αυτής της πληροφορίας 

εξελίσσεται ο ΓΑ. 
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3.   Πιθανοκρατική επιλογή των ατόµων σύµφωνα µε την αρχή της επιβίωσης του 

καλύτερου. Λύσεις µε µεγάλη τιµή αξιολόγησης είναι πιθανότερο να επιλεγούν 

για την διαδικασία της αναπαραγωγής. 

4.   Εφαρµογή Γενετικών Τελεστών όπως η διασταύρωση και η µετάλλαξη. Τα 

άτοµα που επιλέχθηκαν είτε θα ανασυνδυαστούν είτε θα περάσουν αυτούσια στην 

επόµενη γενιά σαν ένα είδος κλωνοποίησης. 

5.   Αντικατάσταση των ατόµων της τρέχουσας γενιάς από τους απογόνους. 

Γενεαλογική αντικατάσταση των ατόµων που πραγµατοποιείται ολικά 

(ολόκληρος ο πληθυσµός) ή µερικά (ένα τµήµα του βάση κάποιου ποσοστού). 

6.   Τερµατισµός του Γενετικού Αλγόριθµου. Αν ικανοποιηθούν κάποια κριτήρια 

τερµατισµού (αριθµός γενεών ή σύγκλιση της ποιότητας των ατόµων σε µια 

επιθυµητή τιµή) η εξέλιξη τερµατίζει. 

 
 
ΤΕΧΝΙΚΗ ΠΕΡΙΓΡΑΦΗ 
 

   Η µορφή µε την όποια διατηρούνται τα άτοµα-λύσεις του πληθυσµού δεν είναι η 

κανονική τους αλλά µια κωδικοποιηµένη µορφή. Για να περιγράψουµε αυτήν την 

µορφή κωδικοποίησης θα πρέπει να χρησιµοποιήσουµε κάποιους όρους από τον χώρο 

των βιολογικών επιστηµών, αφού οι ΓΑ στην ουσία είναι εξοµοίωση φυσικών 

βιολογικών συστηµάτων. Έτσι η κωδικοποιηµένη µορφή των ατόµων-λύσεων, η 

οποία εξαρτάται από το είδος του προβλήµατος κάθε φορά, ονοµάζεται γονότυπος 

(genotype), ενώ η αποκωδικοποιηµένη πραγµατική παραµετρική της µορφή 

ονοµάζεται φαινότυπος (phenotype). Ο γονότυπος αυτός αποτελείται από 

χρωµοσώµατα (chromosomes). Στην περίπτωση που ο σχεδιασµός απαιτεί ένα µόνο 

χρωµόσωµα τότε το χρωµόσωµα ταυτίζεται µε τον γονότυπο. Έτσι κάθε λύση-

γονότυπος/χρωµόσωµα είναι κωδικοποιηµένη σε µια συµβολοσειρά (string), τα 

σύµβολα της οποίας  ανήκουν σε ένα όσο το δυνατό µικρό σύνολο συµβόλων. Το πιο 

συνηθισµένο σύνολο συµβόλων είναι το δυαδικό σύνολο {0,1} όπου κάθε λύση είναι 

µία αλληλουχία από 0 και 1. Αν και αρχικά η δυαδική µορφή των λύσεων παρουσίαζε 

µεγάλο ενδιαφέρον, η συνεχώς αυξανοµένη πολυπλοκότητα των προβληµάτων είχε 

ως αποτέλεσµα η δυαδική κωδικοποίηση να αδυνατεί να δώσει λύσεις. Αυτό οδήγησε 

στο να εµφανιστούν γενετικοί αλγόριθµοι µε κωδικοποίηση ατόµων πιο ρεαλιστική 

και την προσαρµογή των διάφορων τελεστών των ΓΑ σε αυτήν. Στην κατεύθυνση 
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αυτή φυσικά βοήθησε και η εµφάνιση διάφορων εργαλείων αντικειµενοστραφούς 

προγραµµατισµού. Για ένα παράδειγµα  µιας τριαδικής κωδικοποίησης µε σύνολο                     

συµβόλων {0,1,#} , θα πραγµατοποιούνταν αναπαράσταση των ατόµων µε 0,1 και #, 

και ο γενετικός τελεστής µετάλλαξης σ’ αυτήν την περίπτωση θα µετέτρεπε το 0 σε 

1και # µε ίση πιθανότητα και αντίστοιχα τα υπόλοιπα σύµβολα. 

       Στο σχήµα 3 φαίνεται ένας γονότυπος αποτελούµενος από πολλές µεταβλητές ή 

χρωµοσώµατα που είναι κωδικοποιηµένος σε δυαδική µορφή. Αν κάθε µεταβλητή 

έπαιρνε τιµή από το διάστηµα {-χ … χ} θα µπορούσε να κωδικοποιηθεί µε έναν ν-bit 

αριθµό σε 2ν διαφορετικές τιµές. Το βήµα διακριτοποίησης που αντιστοιχεί το κάθε 

bit θα είναι 2χ / 2ν . Το βήµα µπορούµε να το προσαρµόσουµε κατάλληλα ώστε να 

αυξήσουµε την απόδοση της  κωδικοποίησης. 

 

 

Μεταβλητή 1

0 1 1 1 0 . . .  0

01110 . . 0 11100 . . 1 01101 . . 1. .

Μεταβλητή N. .

0 1 1 0 1 . . . 1
Συµβολοσειρά 1

. .

Ενιαία συµβολοσειρά λύσης (γονότυπος)

Συµβολοσειρά N

 
 

Σχήµα 3. Η κωδικοποίηση µίας λύσης πολλών µεταβλητών σε 
µία ενιαία δυαδική συµβολοσειρά (γονότυπος). 

 

 

   Μια περαιτέρω ανάλυση της κωδικοποίησης  είναι τα γονίδια (genes), από τα οποία 

αποτελούνται τα χρωµοσώµατα. Το κάθε σύµβολο δηλαδή που είναι διατεταγµένο 

στη γραµµική ακολουθία. Ακόµη τα γονίδια που επηρεάζουν την συµπεριφορά του 

γονότυπου βρίσκονται σε συγκεκριµένες θέσεις που ονοµάζονται locus (position). 

Τέλος κάθε χρωµόσωµα µπορεί να πάρει µόνο επιτρεπτές τιµές και οι οποίες 

καλούνται alleles (καταστάσεις ενός γνωρίσµατος).      
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Αξιολόγηση του Πληθυσµού 
 

   Μετά την παράγωγη του πληθυσµού όπου το γονίδιο κάθε χρωµοσώµατος (ή 

γονότυπου στην περίπτωση που έχουµε ένα χρωµόσωµα) παίρνει τυχαία τιµή από το 

σύνολο των συµβόλων, έρχεται η διαδικασία της αξιολόγησης των λύσεων. Η 

διαδικασία αυτή πραγµατοποιείται µε την βοήθεια µιας συνάρτησης καταλληλότητας 

που δείχνει την σπουδαιότητα κάθε λύσης-ατόµου µέσα στον πληθυσµό. Ονοµάζεται 

συνάρτηση ποιότητας  ή συνάρτηση αξιολόγησης (quality ή fitness function). Μέσω 

αυτής σε κάθε άτοµο δίδεται µια τιµή η οποία αντιπροσωπεύει πόσο καλά 

προσαρµοσµένη είναι η κάθε λύση στις εξωτερικές συνθήκες του περιβάλλοντος. 

Συνεπώς όσο πιο προσαρµοσµένο είναι ένα άτοµο τόσο µεγαλύτερη θα είναι και η 

τιµή που του αντιστοιχίζεται βάση της οποίας θα επιλεγεί για αναπαραγωγή. Έτσι οι 

υψηλόβαθµες λύσεις έχουν µεγαλύτερη πιθανότητα να κληροδοτήσουν τα “γενετικά” 

τους χαρακτηριστικά. Η συνάρτηση αυτή είναι δηλαδή ο λόγος που οδεύουµε στην 

βελτιστοποίηση του ΓΑ.  

 
Επιλογή Γονέων    
 

   Αφού αποτιµηθούν όλα τα άτοµα-λύσεις του πληθυσµού, ξεκινάει η διαδικασία 

επιλογής των γονέων (selection procedure) ώστε να ανασυνδυαστούν τα άτοµα και να 

παραχθεί η νέα γενιά.  Ο καινούργιος πληθυσµός δηµιουργείται µε την επιλογή των 

όσο καλυτέρα προσαρµοσµένων ατόµων, δηλαδή των ατόµων µε τις µεγαλύτερες 

τιµές καταλληλότητας που προκύπτουν από την συνάρτηση ποιότητας. Βέβαια δεν 

αποκλείονται από την επιλογή άτοµα µε µικρή τιµή καταλληλότητας, εφόσον 

ενδέχεται ο συνδυασµός µιας καλής και µιας κακής λύσης ή ακόµη και ο συνδυασµός 

δύο κακών λύσεων να δώσει λύσεις µε καλύτερη ποιότητα.  Για τον σκοπό αυτό 

έχουν αναπτυχθεί διάφορες µέθοδοι επιλογής, όπως: 

 

• Αναλογική επιλογή (proportionate selection), όπου τα άτοµα επιλέγονται 

αναλογικά, σύµφωνα µε την ποιότητας τους 

• Επιλογή µε ∆ιαβάθµιση (ranking selection), όπου τα άτοµα του πληθυσµού 

ταξινοµούνται είτε µε αύξουσα είτε µε φθίνουσα σειρά και ο αριθµός των 

φορών που θα επιλεγούν είναι συνάρτηση του αριθµού ταξινόµησης τους.           
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• Boltzmann επιλογή (Boltzmann selection), όπου σε κάθε άτοµο η τιµή 

αξιολόγησης f τροποποιείται σε f’ που παράγεται µε βάση την συνάρτηση f’= 

(1+exp (f/T)-1), και την µεταβλητή Τ να χρησιµοποιείται µε παρόµοιο τρόπο 

µε αυτόν της θερµοκρασίας στην κατανοµή Boltzmann 

• Επιλογή µε Τουρνουά (tournament selection), όπου για την επιλογή του κάθε 

γονέα επιλέγεται τυχαία ένας υποπληθυσµός µέσα στον οποίο ο καλύτερος 

κερδίζει και συµµετέχει στην αναπαραγωγή.    

 

   Στα προγράµµατα που ακολουθούν (SCS-CCS) χρησιµοποιήθηκε επιλογή γονέων 

µε τον Τροχό της Ρουλέτας (Roulette Wheel Parent Selection), που είναι ένα 

αντιπροσωπευτικό είδος αναλογικής επιλογής. Στην µέθοδο αυτή ο γονέας επιλέγεται 

µε πιθανότητα ανάλογη της ποιότητας του. Πήρε την ονοµασία της επειδή θυµίζει το 

γύρισµα του τροχού της ρουλέτας στην οποία το εµβαδό κάθε κοµµατιού της, 

αντιστοιχίζεται στην ποιότητα των γονέων (βλ. σχήµα  4).     

 

 

 
 
 
Ανασυνδυασµός των Λύσεων-∆ιασταύρωση 
 

   Είναι καιρός να δούµε τους γενετικούς τελεστές πιο αναλυτικά. Ένας γενετικός 

τελεστής είναι µια διαδικασία που προσοµοιάζει την αντίστοιχη διαδικασία του 

ζευγαρώµατος των βιολογικών ειδών , στην ουσία της ανάµιξης των χρωµοσωµάτων 

κατά την φάση της αναπαραγωγής. Κύριος και πιο σηµαντικός γενετικός τελεστής 
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είναι ο τελεστής διασταύρωσης (crossover). Ο τελεστής αυτός συνδυάζει τα 

χαρακτηριστικά γνωρίσµατα των ατόµων που έχουν επιλεγεί σύµφωνα µε τις 

µεθόδους που έχουν περιγραφεί στην προηγούµενη παράγραφο, ώστε να 

δηµιουργηθούν καινούρια άτοµα που θα πάρουν την θέση των γονέων τους στον 

πληθυσµό. Έτσι τα γενετικά χαρακτηριστικά µεταφέρονται από γενιά σε γενιά και 

λόγω της αρχής της επιβίωσης των καλύτερων ο αλγόριθµος συγκλίνει προς την 

βέλτιστη ή βέλτιστες λύσεις. 

   Οι πιο συνηθισµένοι τρόποι διασταύρωσης είναι οι εξής: 

 

• ∆ιασταύρωση ενός σηµείου (One Point Crossover). Έστω ότι έχουν 

επιλεγεί δύο άτοµα για αναπαραγωγή τα οποία είναι κωδικοποιηµένα όχι σε 

δυαδική µορφή αλλά µε τα εξής 5 γονίδια: 

A= {1, 2, 3, 4, 5} και B= {α, β, γ, δ, ε} 

               Σύµφωνα µε την διασταύρωση ενός σηµείου  τα παραγόµενα άτοµα θα είναι       

            τα έξης: 

 

Γονείς        Απόγονοι

1, 2, 3, | 4, 5            1, 2, 3, | δ, ε 

→ 
α, β, γ, | δ, ε            α, β, γ, | 4, 5 

 

                Η κάθετη γραµµή είναι το σηµείο διασταύρωσης. Στην συγκεκριµένη     

             περίπτωση το σηµείο 3. 

 

• ∆ιασταύρωση πολλών σηµείων (Multi-Point Crossover). Η περίπτωση 

αυτή είναι µια πιο γενική, όπου έχουµε περισσότερα σηµεία 

κοπής/διασταύρωσης. Εδώ οι γονείς χωρίζονται σε περισσότερα από 2 

τµήµατα  και οι απόγονοι παράγονται µε εναλλαγή των τµηµάτων των 

γονέων. 
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• Οµοιόµορφη ∆ιασταύρωση (Uniform Crossover). Μια πιο ειδική 

περίπτωση είναι αυτή της οµοιόµορφης διασταύρωσης όπου κάθε γονίδιο έχει 

την ίδια  πιθανότητα να ληφθεί είτε από τον ένα είτε από τον άλλο γονέα. 

 

   Είναι φανερό ότι ο πιο αποδοτικός τρόπος διασταύρωσης είναι αυτός της 

οµοιόµορφης. Παρακάτω φαίνεται σχηµατικά πως λειτουργεί η διασταύρωση: 

 

 

Γονέας 1
Γονέας 2

Απόγονος 1
Απόγονος 2

Σηµεία Crossover

 
 

Σχήµα 5. Ο τελεστής ∆ιασταύρωσης (Crossover) ανασυνδυάζει τις 
κωδικοποιηµένες λύσεις. 

 

Είναι σηµαντικό να αναφερθεί ότι ο τελεστής αυτός δεν εφαρµόζεται πάντα. Υπάρχει 

µια πιθανότητα για να εφαρµοστεί που ονοµάζεται πιθανότητα διασταύρωσης 

(crossover probability). Η πιθανότητα αυτή λαµβάνει τιµές στο διάστηµα [0,1], µε 

συνήθεις τιµές από 0.7 έως 0.9 . Έτσι κατά την διάρκεια του ΓΑ παράγεται ένας 

τυχαίος αριθµός όπου αν είναι µικρότερος ή ίσος της πιθανότητας διασταύρωσης τότε 

τα επιλεγµένα άτοµα-γονείς ανασυνδυάζουν τα γενετικά χαρακτηριστικά τους, 

αλλιώς αν είναι µεγαλύτερος στην επόµενη γενιά περνάνε οι ίδιοι οι γονείς  και τα 

γενετικά τους χαρακτηριστικά παραµένουν αναλλοίωτα.     

   Παρόλο που ο τελεστής διασταύρωσης δηµιουργεί καινούργιες λύσεις δεν παράγει 

καινούργια πληροφορία. Αν για παράδειγµα ανασυνδυαστούν δύο όµοιοι γονείς το 

αποτέλεσµα θα είναι ίδιο µε τις αρχικές λύσεις-άτοµα.   
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Μετάλλαξη  
 

   Όπως είπαµε ο µηχανισµός της διασταύρωσης δεν παράγει καινούργια πληροφορία 

για αυτό χρησιµοποιείται ένας άλλος τελεστής που ονοµάζεται τελεστής µετάλλαξης 

(mutation). Ο τελεστής αυτός παράγει τυχαιότητα και ευελιξία στον ΓΑ και 

εφαρµόζεται επίσης µε κάποια πιθανότητα την πιθανότητα µετάλλαξης (mutation 

probability). Η παράµετρος αυτή παίρνει τιµή κοντά στο 0.01 ανά bit (ή γονίδιο). 

Βέβαια η εφαρµογή της δεν µας εγγυάται ότι η τροποποίηση των ατόµων µε τον 

τελεστή αυτό θα µας δώσει καλύτερες λύσεις αλλά σίγουρα θα µας δώσει την 

ευκαιρία να εξερευνήσουµε όλο τον χώρο λύσεων χωρίς να αποκλείσουµε κάποιο 

τµήµα του.  

   Παρακάτω θα αναφέρουµε δύο τρόπους εφαρµογής αυτού του τελεστή. 

    

1. Αν για παράδειγµα σε έναν γενετικό αλγόριθµο που χρησιµοποιεί δυαδική 

κωδικοποίηση έχουµε το προς µετάλλαξη άτοµο των 10 bits,  

0011000101 

   ∆ιατρέχουµε το κάθε bit ξεχωριστά και παράγουµε έναν τυχαίο αριθµό. Αν είναι 

µικρότερος από την πιθανότητα µετάλλαξης τότε το αντίστοιχο bit θα µεταλλαχθεί. 

Στην περίπτωση της δυαδικής µορφής που έχουµε και στο παράδειγµα µας θα 

ισχύουν οι εξής µετατροπές: 

0 → 1     και     1 → 0 

Αν λοιπόν υποθέσουµε ότι για το bit στη θέση τρία έχουµε ίση ή µικρότερη 

πιθανότητα από αυτή της µετάλλαξης τότε το άτοµο θα µεταβληθεί σε: 

00 0 1000101 

2.   Ένας άλλος τρόπος είναι να βρούµε το γινόµενο µεταξύ του πλήθους των bits και  

της πιθανότητας µετάλλαξης. Στη συνέχεια κρατάµε το ακέραιο µέρος από τον 

παραγόµενο αριθµό και παράγουµε έναν τυχαίο αριθµό που αν είναι µικρότερος ή 

ίσος του δεκαδικού µέρους τότε το ακέραιο µέρος το αυξάνουµε κατά ένα. Ο 

ακέραιος δηλώνει πόσα bit  θα µεταλλαχθούν. Για να βρούµε ποιες είναι οι θέσεις 

των bit που θα µεταλλαχθούνε παράγουµε τόσους τυχαίους αριθµούς όση είναι και η 

τιµή του ακεραίου.    
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Ελιτισµός 
 

   Κάτι που δεν αναφέρθηκε µέχρι τώρα αλλά χρήζει µεγάλης σηµασίας για έναν ΓΑ 

είναι ο µηχανισµός της Επιλεκτικότητας ή Ελιτισµού (Elitism). Συνίσταται στο να 

διατηρεί την καλύτερη λύση κάθε γενιάς και να την περνάει στην επόµενη, ανέπαφη. 

Ο Ελιτισµός είναι σηµαντικός σε έναν γενετικό αλγόριθµο λόγω του ότι οι δύο 

προηγούµενοι τελεστές µπορεί να µεταβάλλουν την απόδοση ενός ατόµου (που 

µπορεί να τυγχάνει να είναι η καλύτερη λύση της τρέχουσας γενιάς) αρνητικά είτε µε 

τον ανασυνδυασµό είτε µε την τυχαία αλλαγή κάποιου bit. Μ’ αυτόν τον τρόπο 

καθορίζεται σίγουρα ότι µέσα στον πληθυσµό θα υπάρχει µία λύση µε απόδοση ίση ή 

µεγαλύτερη από  την καλύτερη λύση της προηγούµενης γενιάς. Έτσι ο ΓΑ παράγει σε 

κάθε γενιά ένα άτοµο λιγότερο αφού το τελευταίο άτοµο είναι αυτό που προκύπτει 

από τον ελιτισµό. Τέλος, να σηµειωθεί ότι ο Ελιτισµός έχει εφαρµοστεί στα 

προγράµµατα. 

 

Άλλοι Γενετικοί Τελεστές 
 

   Υπάρχουν βέβαια και παραλλαγές των τελεστών που είδαµε µέχρι τώρα. Για τον 

τελεστή διασταύρωσης: 

Η αντιστροφή (Inversion), όπου επιλέγεται κάθε άτοµο ξεχωριστά και πάνω σ’ αυτό 

παίρνουµε δύο σηµεία µε οµοιόµορφη τυχαία κατανοµή. Ύστερα αναδιατάσσουµε 

αντίστροφα τα bit που βρίσκονται ανάµεσα στα δύο σηµεία κοπής του γονότυπου. Ο 

τελεστής αυτός έχει κυρίως εφαρµογή σε προβλήµατα διάταξης. Για παράδειγµα: 

Επιλεγµένος Γονότυπος:     1 2 3 | 4 5 6 | 7 8 9 

 

                                                                          Σηµεία κοπής 
 

Παραγόµενος Γονότυπος:     1 2 3 | 6 5 4 | 7 8 9  

 

Ανασυνδυασµός Μερικού Ταιριάσµατος (Partially Matched Crossover PMX). Ο 

τελεστής αυτός εφαρµόζεται σε δύο επιλεγµένους γονείς. Σε κάθε γονότυπο 

λαµβάνονται δύο σηµεία κοπής. Μέσα στην περιοχή αυτή το κάθε bit από τον έναν 

γονότυπο αντιστοιχίζεται βάση της θέσης του µε το αντίστοιχο  bit  στον άλλο 
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γονότυπο. Τέλος αλλάζουµε τα bit αναµεταξύ τους όχι µόνο ανάµεσα στα σηµεία 

κοπής άλλα σε όλο το µήκος του γονότυπου. Για παράδειγµα: 

Γονότυπος 1:     5 6 4 | 9 1 2 | 7 3 8 

Γονότυπος 2:     2 1 3 | 4 7 6 | 5 8 9 

 

                                                                Σηµεία κοπής 
 

Απόγονος 1:     5 2 9 | 4 7 6 | 1 3 8 

Απόγονος 1:     6 7 3 | 9 1 2 | 5 8 4 

 

   Άλλοι σηµαντικοί ανασυνδυαστικοί τελεστές είναι: 

 Ανασυνδυασµός ∆ιάταξης (Order Crossover OX) 

 Κυκλικός Ανασυνδυασµός (Cycle Crossover CX) 

 Ανασυνδυασµός Ακµών (Edge Recombination ER)  

   Όσον αφορά τον τελεστή µετάλλαξης, µερικές παραλλαγές   είναι: 

 Μετάλλαξη τυχαίου χρωµοσώµατος (Random Chromosome). Εδώ 

επιλέγεται ένα χρωµόσωµα τυχαία και επανακαθορίζεται µέσα από το πεδίο 

ορισµού του. 

 Μετάλλαξη Τυχαίου Γονότυπου (Random Genotype). Ολόκληρος ο 

γονότυπος επανακαθορίζεται όπως ένας γονότυπος καθορίζεται κατά την 

φάση αρχικοποίησης του πληθυσµού. 

 Μετάλλαξη Εναλλαγής χρωµοσωµάτων (Swap Chromosome). 

Χρησιµοποιείται σε προβλήµατα µε πολλές µεταβλητές. Εδώ η διαδικασία 

που λαµβάνει χώρα είναι η  ανταλλαγή δυο χρωµοσωµάτων µεταξύ τους. 

 Μετάλλαξη Εναλλαγής Bits/Τµηµάτων Χρωµοσωµάτων. Λειτουργεί 

παρόµοια µε τον παραπάνω τελεστή µόνο που αντί να εναλλάσσει ολόκληρο 

το χρωµόσωµα µε ένα άλλο, εναλλάσσει ένα ή περισσότερα bit του 

συγκεκριµένου χρωµοσώµατος. 
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   Όλες οι παραπάνω παραλλαγές του ανασυνδυαστικού τελεστή και του τελεστή 

µετάλλαξης αποτελούν ειδικές µορφές και χρησιµοποιούνται σε συγκεκριµένα 

προβλήµατα (Problem Specific), ώστε να επιτύχουν βελτιστοποίηση του ΓΑ για 

γρηγορότερη σύγκλιση προς τις καλύτερες λύσεις. 

 

Τελεστές Αναρρίχησης (Hill Climbing Operators). Οι γενετικοί αλγόριθµοι, λόγω 

της δοµής τους πολλές φορές είναι αναγκασµένοι να επιτρέψουν να περάσει ένα 

µεγάλο πλήθος γενεών ώσπου να συγκλίνουν προς το βέλτιστο. Για τον λόγο   αυτό 

συνεργάζονται πολλές φορές µε διάφορες µεθόδους. Μια τέτοια συνεργασία είναι και 

αυτή των γενετικών αλγορίθµων µε τους τελεστές αναρρίχησης οι οποίοι 

κατευθύνονται από την τοπική κλίση της συνάρτησης ποιότητας (σχήµα 6). Αυτό που 

συµβαίνει στον παραπάνω συνδυασµό, είναι πως η καλύτερη λύση κάθε γενιάς 

στέλνεται στην µέθοδο αυτή. Η εφαρµογή της µεθόδου συνίσταται ώστε να 

εξερευνηθεί καλύτερα η “γειτονιά” του χώρου λύσεων του καλύτερου ατόµου. Μετά 

την εκτέλεση της µεθόδου, και την µικρή µεταβολή που επέρχεται,  η λύση 

επαναξιολογείτε. Αν η παραγόµενη είναι καλύτερη σε ποιότητα από την αρχική λύση 

τότε εισάγεται στον πληθυσµό στην θέση της αρχικής, αλλιώς κρατάµε την αρχική 

λύση και είτε δοκιµάζεται µια νέα µεταβολή, είτε η διαδικασία αυτή σταµατά.         

      

 
   

   Μερικοί σηµαντικοί τελεστές αναρρίχησης είναι: 

 Τελεστής Αναρρίχησης Μετάλλαξης Φαινοµένου (Mutation Phenotype 

HCO) 
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 Συνδυαστικός Τελεστής Αναρρίχησης (Swap Bit HCO) 

 Τελεστής Συµπλήρωσης Κενών (Fill Gap HCO) 

 

Αντικατάσταση Πληθυσµού 
 
 
   Εφόσον έχουν παραχθεί και αξιολογηθεί οι απόγονοι υπάρχει άλλη µια διεργασία 

που λαµβάνει  µέρος στους γενετικούς αλγόριθµους. Θα πρέπει λοιπόν αυτές οι 

καινούργιες λύσεις να εισέλθουν στον πληθυσµό. Για τον λόγο αυτό έχουν 

αναπτυχθεί διάφορες µέθοδοι αντικατάστασης των γονέων από τους απογόνους 

(Γενεαλογική Αντικατάσταση) όπως: 

 

 Ολική Αντικατάσταση (Total Replacement). Ο πληθυσµός των απογόνων 

διαδέχεται πλήρως τον πληθυσµό των γονέων.   

 Μερική Αντικατάσταση (Partial Replacement). Ένα τµήµα των γονέων 

(συνήθως οι χειρότεροι) αντικαθιστάτε από ένα ισοδύναµο τµήµα των 

απογόνων (συνήθως τους καλύτερους). Το τµήµα αυτό καθορίζεται µε κάποιο 

ποσοστό.   

 Αντικατάσταση Σταθερής Κατάστασης (Steady State Replacement). Στην 

περίπτωση αυτή όταν παραχθεί µια λύση αντικαθιστά µία υπάρχουσα 

(συνήθως την χειρότερη του τρέχοντα πληθυσµού). 

 

Τερµατισµός του Γενετικού Αλγόριθµου 
 
 
   Ως πότε θα “τρέχει” ένας ΓΑ ή αλλιώς ως πότε θα διαδέχεται η µία γενιά την άλλη;  

   Ο τερµατισµός των ΓΑ γίνεται µε βάση την ποιότητα των λύσεων ή βάση του 

αριθµού των γενεών. Στην πρώτη περίπτωση όπου σαν κριτήριο έχουµε την ποιότητα, 

ο αλγόριθµος σταµατά όταν οι βέλτιστες λύσεις έχουν συγκλίνει σε µια επιθυµητή 

τιµή ποιότητας. ∆εν είναι απαραίτητο µια µόνο λύση  να φτάσει αυτήν την ποιότητα 

αλλά ακόµη και ένα µεγάλο ποσοστό του πληθυσµού να συγκεντρωθεί σε ένα τοπικό 

βέλτιστο. Στην περίπτωση που ο  αριθµός των γενεών  είναι το κριτήριο τερµατισµού 

η εξέλιξη σταµατά όταν φτάσουµε ένα απόλυτο όριο γενεών (π.χ. 1000 γενιές) ή  

επίσης µπορεί να τροποποιηθεί ώστε όταν περάσει ένας αριθµός γενεών και δεν 

παραχθεί καλύτερη λύση, η εξέλιξη του ΓΑ να σταµατά πάλι. Βέβαια θα µπορούσαν 
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να αναπτυχθούν κι άλλα κριτήρια τερµατισµού ανάλογα µε την φύση του 

προβλήµατος.     

 

   Με τα όσα αναλύσαµε µέχρι τώρα θα µπορούσαµε να αναπαραστήσουµε σε ένα 

διάγραµµα ροής την εξέλιξη ενός γενετικού αλγόριθµου όπως φαίνεται παρακάτω 

(σχήµα 7). 

 
 

 

Ιδιότητες Γενετικών Αλγορίθµων 
 

   Οι γενετικοί αλγόριθµοι είναι όπως είπαµε αλγόριθµοι αναζήτησης και 

βελτιστοποίησης. Τα χαρακτηριστικά που τους κάνουν τόσο χρήσιµους και τους 

παρέχουν την ιδιότητα της ευρωστίας είναι τα εξής: 

1. Επεξεργάζονται κωδικοποιηµένες λύσεις (γονότυπους) και όχι την ίδια 

την λύση 
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2. Έχουν την δυνατότητα της παράλληλης και ταυτόχρονης διερεύνησης 

των υποψήφιων λύσεων του προβλήµατος. Σε αντίθεση µε άλλες µεθόδους 

που επεξεργάζονται µια προς µία της λύσης µε κίνδυνο η αναζήτηση του 

βέλτιστου να εγκλωβιστεί σε ένα τοπικό ακρότατο, οι γενετικοί µε την 

δυνατότητα της ταυτόχρονης επεξεργασίας πολλών λύσεων έχουν µεγαλύτερη 

πιθανότητα να φτάσουν σε ένα απόλυτο τοπικό µέγιστο. Στην πορεία αυτή 

βοηθάνε ακόµη περισσότερο και οι τελεστές αναρρίχησης που αναφέρθηκαν 

πιο στην προηγούµενη ενότητα. 

3. Όλες οι απαραίτητες πληροφορίες που χρειάζονται πηγάζουν από την 

συνάρτηση ποιότητας. Εδώ όµως δηµιουργείται η απορία µήπως 

αποκλείουµε έτσι χρήσιµη πληροφορία από άλλα στοιχεία. Για τον λόγο αυτό 

υπάρχουν και γενετικοί αλγόριθµοι που λαµβάνουν και αξιοποιούν και από 

άλλα µέσα πληροφορία. 

4. Λειτουργούν µε τρόπο πιθανοκρατικό, στοχαστικό, και ευριστικό. 

Χρησιµοποιούν δηλαδή την πιθανότητα για να έχουν µεγαλύτερη τυχαιότητα 

και ευελιξία και να διερευνούν έτσι ανεξερεύνητες περιοχές του χώρου 

λύσεων.    

       

Πλεονεκτήµατα-Μειονεκτήµατα 
 
 
Πλεονεκτήµατα: 

 Μπορούν να ανιχνεύουν ανεξερεύνητες περιοχές  (exploration), και να εκµε-

τάλλευονται τις καλύτερες λύσεις (exploitation). 

 Έχουν την δυνατότητα να ενσωµατώνουν κι άλλες µεθόδους στη δοµή τους. 

 Βρίσκουν εφαρµογή σε πολλούς τοµείς. 

 Παρέχουν πολλές λύσεις. 

Μειονεκτήµατα 

 Πολλές φορές χρειάζονται αρκετό χρόνο µέχρι να συγκλίνουν στο βέλτιστο. 

 Για µεγαλύτερη αποδοτικότητα θα πρέπει κάθε φορά να καθορίζονται οι διάφορες 

παράµετροι. 

 Χρειάζονται αρκετή υπολογιστική ισχύ. 

Γιατί λειτουργούν οι Γενετικοί Αλγόριθµοι; 
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   Με τα όσα αναπτύξαµε κατά την ανάλυση αυτού του κεφαλαίου γεννιέται η απορία 

γιατί οι γενετικοί αλγόριθµοι συγκλίνουν προς το βέλτιστο; τι είναι αυτό που τους 

δίνει την ιδιότητα της ευρωστίας; Για να µπορέσουµε να δώσουµε µια απάντηση, θα 

πρέπει στο σηµείο αυτό να εισάγουµε την έννοια των σχηµάτων και γενικά να 

αναλύσουµε την Θεωρία των Σχηµάτων (Schema Theorem). 

   Υποθέτοντας λοιπόν πως έχουµε ένα πληθυσµό από άτοµα-λύσεις και 

παρατηρώντας τα, θα βλέπαµε πως υπάρχουν κάποιες οµοιότητες ανάµεσα σε κάποια 

άτοµα. Υπάρχουν δηλαδή θέσεις στον γονότυπο κάποιων ατόµων που έχουν την ίδια 

τιµή. Αυτά τα σύνολα των ατόµων που έχουν κοινά στοιχεία παρουσιάζουν 

συστηµατικά καλές ή κακές ποιότητες. Συµπεραίνουµε έτσι πως υπάρχει ένας 

συσχετισµός ανάµεσα στα άτοµα καλών λύσεων αλλά και µεταξύ ποιότητας και  

λύσεων. Πριν ακόµη δώσουµε τον ορισµό  του σχήµατος να εισάγουµε στο αλφάβητο 

µας και το σύµβολο µπαλαντέρ * (don’t care symbol) και να πούµε πως σαν σχήµα 

(Η) µέσα σ’ έναν γενετικό αλγόριθµο που κωδικοποιείται δυαδικά, ορίζεται ένα 

πρότυπο string που αναπαριστά όλες τις συµβολοσειρές οι οποίες  έχουν όλα τα bit 

ίδια εκτός τις θέσεις που υπάρχει ο χαρακτήρας *. 

   Για παράδειγµα, στα παρακάτω άτοµα µήκους 10 bit: 

1. 0101110010 

2. 1101110010 

3. 1111110010 

4. 0111110010 

 το σχήµα  που τα αναπαριστά είναι το *1*1110010. Επίσης το σχήµα 0101110010 

αναπαριστά µία µόνο λύση, την 0101110010 , και το σχήµα ********** αναπαριστά 

όλες τις λύσεις που έχουν µήκος 10 bit.       

   Ο αριθµός των σχηµάτων που υπάρχουν σ’ έναν πληθυσµό µε γονότυπους µήκους ℓ 

είναι 3ℓ, αρκετά µεγαλύτερος από τον αριθµό των λύσεων που είναι 2ℓ. Κάθε 

γονότυπος όµως περιέχει 2ℓ σχήµατα αφού κάθε θέση παίρνει είτε ‘*’ είτε κανονική 

τιµή. Είναι προφανές ότι κάθε σχήµα που περιέχει έναν αριθµό ν συµβόλων 

µπαλαντέρ ‘*’ , µπορεί να αναπαραστήσει 2ν συµβολοσειρές. Έτσι αν ο πληθυσµός 

έχει Μ άτοµα, ο δυνατός αριθµός των σχηµάτων που µπορούν να υπάρξουν σ’ αυτόν 

είναι: 

2ℓ ≤ σχήµατα ≤ M *2ℓ 
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   Στο σηµείο αυτό θα πρέπει να αναφέρουµε δύο µεγέθη που χαρακτηρίζουν τα 

σχήµατα, είναι: η τάξη (order) και το µήκος ορισµού (defining length). 

    Τάξη ενός σχήµατος ο(Η), ορίζεται ο αριθµός των σταθερών συµβολών ή αλλιώς 

των θέσεων που δεν περιέχουν το σύµβολο µπαλαντέρ ‘*’ (wildcard symbol). ∆ηλαδή 

είναι η διαφορά του µήκους του σχήµατος µείον το πλήθος των αδιάφορων 

συµβόλων. 

   Έστω τα ακόλουθα σχήµατα µήκους 10 bits: 

Η1 = {*01*00***1}, 

Η2 = {******01**}, 

Η3 = {100101**10}, 

οι τάξεις των συµβόλων θα είναι: ο(Η1) = 5, ο(Η2)=2, ο(Η3)= 8. Από τα παραπάνω 

σχήµατα καταλαβαίνουµε πως αυτό που έχει τα περισσότερα σταθερά σύµβολα {0,1} 

είναι πιο ειδικό ή µε άλλα λόγια, το λιγότερο γενικό αφού αναπαριστά µικρότερο 

πλήθος συµβολοσειρών. Το µέγεθος αυτό παίζει σηµαντικό ρόλο στην επιβίωση του 

σχήµατος κατά την διάρκεια της µετάλλαξης αφού η πιθανότητα να τροποποιηθεί ένα 

bit είναι pm και άρα η πιθανότητα να επιβιώσει 1- pm. Οπότε η πιθανότητα να 

επιβιώσει ένα σχήµα δεδοµένου ότι η τάξη o(H) εκφράζει τον αριθµό των σταθερών 

συµβόλων ισούται µε: 

ps= (1- pm)o(H)

   Επειδή όµως η πιθανότητα µετάλλαξης είναι σχετικά πολλή µικρή pm<<1 (συνήθως 

ισούται µε 0.01) ,  η πιθανότητα επιβίωσης προσεγγίζεται από την σχέση: 

ps= 1- o(H)·pm

   Σαν µήκος ορισµού ενός σχήµατος δ(Η), ορίζουµε την απόσταση µεταξύ του 

πρώτου και του τελευταίου σταθερού bit. Για τα παραπάνω σχήµατα το οριζόµενο 

µήκος θα είναι: 

δ(Η1)= 10-2 = 8 

δ(Η2)=   8-7 = 1 

δ(Η3)= 10-1 = 9 

   Στην περίπτωση που υπάρχει ένα µόνο σταθερό bit µέσα στον γονότυπο το 

οριζόµενο µήκος είναι µηδέν. 
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   Το µέγεθος αυτό παίζει σηµαντικό ρόλο στην επιβίωση του σχήµατος κατά την 

διάρκεια της διασταύρωσης. Αυτό φαίνεται αν αναλογιστούµε το παρακάτω 

παράδειγµα.  

   Έστω το άτοµο Α = 0111000 µε µήκος 7 και τα παρακάτω σχήµατα: 

Η1= * 1 * * * * 0 

H2= * * * 1 0 * * 

   Η τάξη και το οριζόµενο µήκος για τα δύο σχήµατα είναι αντίστοιχα: 

o(Η1) = 2 και δ(Η1) = 5 

o(Η2) = 2 και δ(Η2) = 1 

   Ενώ και τα δύο σχήµατα έχουν την ίδια τάξη, είναι φανερό πως το πρώτο σχήµα 

µπορεί να διαµελιστεί πιο εύκολα.  

    Σε µια εφαρµογή του τελεστή Crossover µε σηµείο κοπής τη θέση µεταξύ του 3ου 

και 4ου ψηφίου θα βλέπαµε πως µόνο το δεύτερο σχήµα θα διατηρούνταν.   

Α = 0 1 1 | 1 0 0 0 

Η1= * 1 * | * * * 0 

H2= * * * | 1 0 * * 

   Με βάση αυτά υπολογίζεται η πιθανότητα επιβίωσης του σχήµατος αλλά και της 

“καταστροφής” αυτού, συναρτήσει του µήκους ορισµού και του ολικού µήκους του. 

Συγκεκριµένα: 

pd1(Η1) =  δ(Η1) / (ℓ -1) =  5/6 ,   Πιθανότητα καταστροφής Η1

ps1(Η1) =    1- pd1(Η1)    =  1/6 ,  Πιθανότητα επιβίωσης Η1

pd2(Η2) =  δ(Η2) / (ℓ -1) =  1/6 ,   Πιθανότητα καταστροφής Η2

ps2(Η2) =    1- pd2(Η2)    =  5/6 ,  Πιθανότητα επιβίωσης Η2

όπου “ℓ” στις παραπάνω σχέσεις είναι το ολικό µήκος του σχήµατος. Άρα προκύπτει 

πως µε πιθανότητα Crossover ‘pc’ , η επιβίωση ενός σχήµατος Η θα είναι: 

ps(Η) ≥ 1 - pc ×  δ(Η1) / (ℓ -1)   

   Στη συνέχεια θα προσπαθήσουµε να εξάγουµε µια σχέση που να δείχνει την 

εκτίµηση του αριθµού των ατόµων m(H,t+1) που αναπαριστώνται από ένα σχήµα Η 

στη γενιά t+1 και εξαρτάται από την αντίστοιχη τιµή της προηγούµενης γενιάς (t). 
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   Αν για κάποιο σχήµα Η υπάρχει ένας υποπληθυσµός συµβολοσειρών p που 

ταιριάζει µ’ αυτό την χρονική στιγµή t, τότε η µέση απόδοση αυτού του 

υποπληθυσµού θα δίδεται από την σχέση: 

pfiHf
p

i

/)(
1

∑
=

=  

    Όµοια για ολόκληρο τον πληθυσµό A(t) συνολικού πλήθους Μ συµβολοσειρών, η 

µέση τιµή καταλληλότητας του για την γενιά t θα δίνεται από τον αντίστοιχο τύπο: 
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   Αφού επιλεγούν τα Μ άτοµα του πληθυσµού ο εκτιµώµενος αριθµός  των ατόµων 

του σχήµατος Η θα είναι: 
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   Από τις δύο τελευταίες σχέσεις συνεπάγεται ο ακόλουθος τύπος που αναφέρεται 

στον ανασυνδυασµό: 
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   Συνδυάζοντας στον παραπάνω τύπο τους τύπους που αφορούσαν την  διασταύρωση 

και την µετάλλαξη καταλήγουµε στην ζητούµενη σχέση: 
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   Τα συµπεράσµατα που προκύπτουν από αυτήν  την σχέση είναι ότι κάθε σχήµα 

εξαρτάται από τον λόγο της µέσης απόδοσης των συµβολοσειρών που ταιριάζουν µε 

το εκάστοτε σχήµα προς την  µέση τιµή της καταλληλότητας  των συµβολοσειρών 

όλου του πληθυσµού.  Επίσης δηλώνει πως σχήµατα µε απόδοση µεγαλύτερη της 

µέσης τιµής του συνολικού πληθυσµού και µε µικρό οριζόµενο µήκος και µικρή τάξη 
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θα διαιωνίζονται µε ρυθµό εκθετικά αυξανόµενο σε διαδοχικές γενιές ενός γενετικού 

αλγορίθµου,  ενώ αντίθετα σχήµατα ποιότητας µικρότερης του µέσου όρου θα έχουν 

φθίνοντα ρυθµό αντιπροσώπων στις επόµενες γενιές. Αυτό αποτελεί και το Θεώρηµα 

Σχηµάτων (Schema Theorem). Τα σχήµατα λοιπόν και οι σχέσεις τους µε την 

ποιότητα είναι αυτά που εξελίσσουν έναν γενετικό αλγόριθµο προς το βέλτιστο.  

   

Υπόθεση ∆οµικών Στοιχείων (Building Block Hypothesis) 
 

   Αυτό που συµβαίνει στην ουσία είναι πως ο γενετικός χρησιµοποιεί σχήµατα 

µικρής τάξης τα οποία µπορούν και περνούν την πληροφορία µέσα από την 

διασταύρωση. Σε αυτά τα µικρής τάξης σχήµατα που καλούνται ∆οµικά Στοιχεία 

(Building Blocks) οφείλεται η σύγκλιση του αλγορίθµου προς τις καλύτερες λύσεις. 

    

   Τέλος αυτά τα µικρά σχήµατα επεξεργάζονται παράλληλα, από τον γενετικό 

αλγόριθµο (implicit parallelism), χωρίς να χρειάζεται άλλο είδος µνήµης πέραν του 

ίδιου του πληθυσµού.   
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ΥΛΟΠΟΙΗΣΗ ΑΠΛΟΥ CLASSIFIER SYSTEM  
 

ΣΚΟΠΟΣ 
 
   Στόχος του κεφαλαίου αυτού είναι να υλοποιηθεί ένα παράδειγµα ενός απλού 

Classifier συστήµατος χωρίς όµως τον αλγόριθµο κατανοµής βαθµών (Bucket 

Brigade Algorithm). Το σύστηµα θα εξελίσσει γενετικά κανόνες (if then rules) για 

την εύρεση ενός βέλτιστου σετ κανόνων που θα περιγράφει την συνάρτηση εισόδου-

εξόδου ενός δυαδικού πολυπλέκτη 4 σε 1 αλλά και 8 σε 1. 

    

∆υαδικοί Πολυπλέκτες 
 

   Ένας πολυπλέκτης (multiplexer ή mux) είναι µία συσκευή ή ένα κύκλωµα που 

επιλέγει ποια κατάσταση (data) θα σταλθεί στην έξοδο του, βάση της διεύθυνσης 

(address) που βρίσκεται η κάθε κατάσταση. Oι πολυπλέκτες υλοποιούνται µε 

τρανζίστορς. Συνήθως την χρήση του πολυπλέκτη ακολουθεί ο αποπολυπλέκτης 

(demultiplexer) που εκτελεί την αντίθετη διαδικασία. 

   Ένας πολυπλέκτης βρίσκει εφαρµογή κυρίως: 

 Σε αναλογικά και ψηφιακά κυκλώµατα. 

 Στα δίκτυα επικοινωνίας (δροµολογητές, µεταγωγείς, γέφυρες…). 

 Σε διατάξεις αποθήκευσης-µνήµες.   

   Παρακάτω φαίνονται σχηµατικά οι δύο τύποι πολυπλέκτη που χρησιµοποιήθηκαν 

καθώς και οι πίνακες µε τα βέλτιστα σετ κανόνων τους: 

 

Πολυπλέκτης 4 σε 1: 

 

 Κανόνες                       Περίγραµµα 

 
00 0###  : 0               0 Address/0 Signal  
00 1###  : 1               0 Address/1 Signal
01 #0##  : 0               1 Address/0 Signal
01 #1##  : 1               1 Address/1 Signal
10 ##0#  : 0               2 Address/0 Signal
10 ##1#  : 1               2 Address/1 Signal
11 ###0  : 0               3 Address/0 Signal
11 ###1  : 1               3 Address/1 Signal
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   Ο πολυπλέκτης 4 σε 1 έχει Address = 2 bit και Data = 2Address = 4. Επίσης, η Λίστα 

Μηνυµάτων είναι χωρητικότητας 1 bit.     

 

Πολυπλέκτης 8 σε 1:   

 

 

 

 

 

  Κανόνες                                Περίγραµµα 

 
000 0#######  : 0               0 Address/0 Signal  
000 1#######  : 1               0 Address/1 Signal
001 #0######  : 0               1 Address/0 Signal
001 #1######  : 1               1 Address/1 Signal
010 ##0#####  : 0               2 Address/0 Signal
010 ##1#####  : 1               2 Address/1 Signal
011 ###0####  : 0               3 Address/0 Signal
011 ###1####  : 1               3 Address/1 Signal
100 ####0###  : 0               4 Address/0 Signal
100 ####1###  : 1               4 Address/1 Signal
101 #####0##  : 0               5 Address/0 Signal
101 #####1##  : 1               5 Address/1 Signal  
110 ######0#  : 0               6 Address/0 Signal
110 ######1#  : 1               6 Address/1 Signal
111 #######0  : 0               7 Address/0 Signal
111 #######1  : 1               7 Address/1 Signal
 

 
 
 
 
 
 
 

   Αντίστοιχα στον πολυπλέκτη 8 σε 1 έχουµε Address = 3 bit και Data = 2Address = 8 

bit. Κι εδώ, η Λίστα Μηνυµάτων είναι χωρητικότητας 1 bit. 

   Η ανάλυση που ακολουθεί είναι ίδια και για τις δύο περιπτώσεις αφού πριν την 

εκτέλεση του προγράµµατος το µόνο που χρειάζεται για να καθορίσουµε ποιόν 

πολυπλέκτη θέλουµε να χρησιµοποιήσουµε, είναι να ορίσουµε την τιµή του Address 

σε «2» για την περίπτωση του πολυπλέκτη 4 σε 1 και σε «3» για την περίπτωση του 8 

σε 1. 
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Υλοποίηση Προγράµµατος 
 
 
   Ήρθε ο καιρός λοιπόν να εφαρµόσουµε όλα όσα αναπτύξαµε στα προηγούµενα 

κεφάλαια για την υλοποίηση του στόχου µας. 

   Σαν πρώτο βήµα λοιπόν όπως αναφέρθηκε και στο κεφάλαιο των γενετικών 

αλγορίθµων ήταν η παραγωγή του αρχικού πληθυσµού. Κάθε άτοµο αποτελείται από 

ένα σετ κανόνων-µηνυµάτων. Το σετ για τον πολυπλέκτη 4 σε 1 είναι ένα σύνολο 

από 8 Classifiers, ενώ για τον  8 σε 1 είναι 16. Οι τιµές αυτές, τις οποίες θεωρούµε 

εξαρχής γνωστές, αποτελούν και το βέλτιστο σύνολο των σετ για τις δύο περιπτώσεις 

µας. Οι κανόνες αυτοί κωδικοποιήθηκαν µε βάση το τριαδικό αλφάβητο {0,1,#} για 

την συνθήκη και το δυαδικό αλφάβητο {0,1} για το µήνυµα. Ως γνωστόν το σύµβολο 

‘#’ παίζει διπλό ρόλο είτε δηλαδή του ‘0’ είτε του ‘1’.   

   ‘Όπως αναφέρθηκε και στο κεφάλαιο των Classifier Systems, κάθε κανόνας 

χαρακτηρίζεται από µια «δύναµη». Στο πρόγραµµα αυτό του ψηφιακού πολυπλέκτη, 

που αποτελεί µια απλή περίπτωση εκµάθησης ενός  Classifier συστήµατος, δεν 

χρησιµοποιήθηκε το «Σύστηµα Καταµερισµού Βαθµών» (Credit Apportionment 

System) και κατ’ επέκτασιν ο «αλγόριθµος Bucket Brigade». Εποµένως η έννοια της 

δύναµης των κανόνων αποκτάει διαφορετικό νόηµα.  

Η δύναµη λοιπόν στην περίπτωση αυτή χαρακτηρίζει ολόκληρο το άτοµο (σετ 

κανόνων µε βέλτιστο πλήθος κανόνων) και δηλώνει το βαθµό προσαρµοστικότητας 

του ατόµου στο περιβάλλον. Πιο συγκεκριµένα, ο ΓΑ διατηρεί έναν πληθυσµό από 

λύσεις. Κάθε λύση αποτελείται από ένα σετ κανόνων. Για να αξιολογήσουµε µία 

λύση (σετ κανόνων) παρουσιάζουµε στην είσοδο του Classifier System όλους τους 

δυνατούς συνδυασµούς εισόδων(2^(address+data)). Για κάθε είσοδο το σετ των  

κανόνων θα αποκριθεί στην έξοδο µε ένα 0 ή ένα 1 που µπορεί να είναι σωστό ή 

λάθος. Ο αριθµός των φορών που το CS θα δώσει σωστή έξοδο λαµβάνεται ως η 

ποιότητα της συγκεκριµένης λύσης. Για τον πολυπλέκτη 4σε1 ο αριθµός των 

συνδυασµών των εισόδων είναι 64 συνδυασµοί, οπότε ο µέγιστος αριθµός σωστών 

απαντήσεων (και άρα µέγιστη τιµή ποιότητας) θα είναι το 64, ενώ η ελάχιστη τιµή 

είναι προφανώς το 0, ενώ για τον 8σε1 είναι αντίστοιχα 2048 για την µέγιστη τιµή 

ποιότητας και 0 για την ελάχιστη τιµή. Ο αριθµός αυτός αποτελεί την ποιότητα του 

ατόµου και σύµφωνα µε αυτόν επιλέγονται τα άτοµα ώστε να τους εφαρµοστούν οι 
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γενετικοί τελεστές της διασταύρωσης και της µετάλλαξης ή και διάφοροι άλλοι 

τελεστές. 

   Για το πρόγραµµα αυτό υλοποιήθηκε ο γενετικός τελεστής διασταύρωσης πολλών 

σηµείων (Multi-Point Crossover). Επίσης η µετάλλαξη εφαρµόστηκε σύµφωνα µε το 

δεύτερο παράδειγµα  που ορίστηκε στο κεφάλαιο των Γενετικών αλγόριθµών στην 

αντίστοιχη παράγραφο. Και οι δύο αυτοί τελεστές λειτουργούν πιθανοκρατικά, 

δηλαδή βάση κάποιας πιθανότητας που ορίζεται κατά την εκτέλεση του 

προγράµµατος. Επιπλέον εφαρµόστηκε και ένας τελεστής αναρρίχησης ο οποίος 

αποτελεί ένα είδος παραλλαγής του Ανασυνδυαστικού Τελεστή Αναρρίχησης (Swap 

Bit HCO).    

   Ο πληθυσµός των απογόνων που παράγεται βάση των παραπάνω διαδικασιών είναι 

ισοπλήθης µε τον πληθυσµό των γονέων και η γενεαλογική αντικατάσταση που 

πραγµατοποιείται είναι ολική (Total Replacement). 

   Όλη αυτή η διαδικασία επανεκτελείται µέχρι την σύγκλιση του αλγορίθµου προς το 

βέλτιστο.  

   Σαν κριτήρια λοιπόν για τον τερµατισµό χρησιµοποιήθηκαν τρεις περιπτώσεις: 

1. Τερµατισµός µε βάση το πλήθος των γενεών 

2. Τερµατισµός µε βάση την ποιότητα 

3. Τερµατισµός µε βάση και τα δύο παραπάνω κριτήρια. 

     Το πρόγραµµα αυτό λόγω της έλλειψης του «αλγόριθµου Bucket Brigade» 

αποτελεί στην ουσία έναν σύνθετο γενετικό αλγόριθµο κι όχι ένα απόλυτο Classifier 

System. Στο επόµενο κεφάλαιο παρουσιάζεται ένα πιο πολύπλοκο Classifier σύστηµα 

µε χρήση και του Bucket Brigade όπου κάθε άτοµο-λύση είναι µια ξεχωριστή 

οντότητα-κανόνας και όχι ένα σετ κανόνων.  

 

 

ΟΘΟΝΕΣ ΤΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ 

 

Εισαγωγική Οθόνη Επιλογής  

 

Όπως φαίνεται αποτελείται από τρία Buttons. 

 -35- 



Ρόµπης Κωνσταντίνος Πτυχιακή Εργασία  Περιεχόµενα                   

 
 

Η Κύρια οθόνη του προγράµµατος 

 
   Το παρακάτω σχήµα αποτελεί την φόρµα του Simple Classifier System: 

 

 
 
   Παρατηρούνται τα εξής Components: 
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StringGrid1 (Αριστερά): Σε αυτό εµφανίζεται ο αρχικός παραγόµενος πληθυσµός 

StringGrid2 (Μέση): Εδώ εµφανίζονται οι δυνατοί συνδυασµοί εισόδων µε τις  

                                  αντίστοιχες εξόδους  

StringGrid3 (∆εξιά): Εδώ εµφανίζεται η καλύτερη λύση κάθε γενιάς. 

RUN Button: Ξεκινά την γενετική εξέλιξη του Classifier System.   

STOP Button: Σταµατά ανά πάσα στιγµή την διαδικασία. 

Quit Label: Τερµατισµός της εφαρµογής. 

Labels (Address, Population, Crossover Probability, Mutation Probability): 

∆είχνουν τις τιµές που έχουν οριστεί από τον χρήστη. 

Main Menu: Εµφανίζει τις επιλογές του προγράµµατος που είναι δυνατές για τον  

                      χρήστη. 

Generation Edit Box: Εδώ εισάγεται το πλήθος των επιθυµητών γενεών. 

Fitness Edit Box: Εδώ εισάγεται η τιµή της επιθυµητής ποιότητας σύγκλισης. 

Status Bar: ∆είχνει την κατάσταση στην οποία βρίσκεται το πρόγραµµα. 

MAIN MENU 

1. FILE 
 

 
 

File->Start: Ξεκινά την γενετική εξέλιξη του Classifier System. 

File->Default FormSize: Επανακαθορισµός του αρχικού µεγέθους της φόρµας. 

File->Root Menu: Επιστροφή στην αρχική φόρµα. 

File->Exit: Τερµατισµός εφαρµογής. 

 

2. INITIAL 
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Initial->Parameters: Εµφανίζει την φόρµα Initial. 

 

3. TERMINATE 

 

 
 

Terminate-> Limit Generation: Τερµατισµός µε απόλυτο όριο γενεών 

Terminate->Limit Fitness: Τερµατισµός µε απόλυτο όριο ποιότητας. 

Terminate->Generation & Fitness: Τερµατισµός µε συνδυασµό και των δύο. 

 

4. OPERAND 

 

 
 

Operand-> HillClimber: Ο χρήστης επιλέγει αν στην γενετική εξέλιξη θα 

συµµετάσχει και ο τελεστής Αναρρίχησης (αποτελεί µια παραλλαγή του Swap Bit 

HCO).  

 

5. HELP 
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Help-> SCS Help: Εµφανίζει το Help της εφαρµογής. 

Help-> About: Εµφανίζει την φόρµα About. 

 

Η Οθόνη Αρχικοποίησης Τιµών INITIAL 

 

 

   Αποτελείται από τα εξής Components: 

Address Edit: Εδώ εισάγετε η τιµή του address των κανόνων. 

Population Edit: Εδώ εισάγετε το πλήθος των κανόνων (Population of Classifier  

                            Store). 

Crossover Points Edit: Εδώ εισάγετε ο αριθµός των σηµείων κοπής από τον χρήστη. 

Crossover Probability Edit: Εδώ εισάγετε η πιθανότητα διασταύρωσης.  

Mutation Probability Edit: Εδώ εισάγετε η πιθανότητα µετάλλαξης. 
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   Αν δεν οριστούν τα παραπάνω µεγέθη καθώς και τα όρια τερµατισµού τότε δεν 

µπορούµε να τρέξουµε τον αλγόριθµό και η εφαρµογή µας ενηµερώνει µε αντίστοιχο 

µήνυµα για την εισαγωγή των δεδοµένων. 

  

Η Οθόνη About 

  

 
   Εδώ εµφανίζεται η Modal φόρµα About και οι πληροφορίες που περιέχονται σ’ 

αυτήν. 
 

ΜΗΝΥΜΑΤΑ ΤΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ 

 
ΕΛΛΕΙΠΗ ΑΡΧΙΚΟΠΟΙΗΣΗ ∆Ε∆ΟΜΕΝΩΝ 

 

 

 
   Εµφανίζετε όταν εκτελείται το Button RUN ή το File-> Start, χωρίς να έχουν 

οριστεί όλα τα δεδοµένα (Address, Population, Crossover Probability, Mutation 

Probability, Fitness or Generation).  
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ΕΠΑΝΑΚΑΘΟΡΙΣΜΟΣ ΤΩΝ ΠΑΡΑΜΕΤΡΩΝ 

 

 

   Παρόµοιο µήνυµα παράγεται για όλα τα δεδοµένα στην περίπτωση που αντί για 

αριθµός πατηθεί κατά λάθος κάποιος χαρακτήρας στο αντίστοιχο Edit Box.  

 

Απόδοση του προγράµµατος 

 

   Ακολουθεί ένα πείραµα που δείχνει την αποτελεσµατικότητα του προγράµµατος. 

Για τον σκοπό αυτό έγινε εκτέλεση του προγράµµατος µε τα παρακάτω δεδοµένα: 

 

Address = 2 

Population = 100 

Crossover Points= 4 (∆ιαλέγεται ένα νούµερο από το 1 έως το 55) 

Crossover Probability = 1,0 

Mutation Probability = 0,01 

Generation = 3000 

 

Ο παρακάτω πίνακας δείχνει τα αποτελέσµατα της εκτέλεσης για πλήθος 10 φορών: 

 

a/a Generation Fitness
1 3000 58 
2 808 64 
3 3000 61 
4 2247 64 
5 3000 55 
6 2038 64 
7 3000 61 
8 3000 59 
9 3000 53 
10 3000 61 
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   Μερικά συµπεράσµατα που διεξάγονται από αυτόν τον πίνακα είναι πως ο 

αλγόριθµος συγκλίνει µε µέσο όρο γενεών: 2609 γενεές και µε µέσο όρο ποιότητας: 

57 ταιριάσµατα ποιότητας. Επίσης παρατηρείτε, πως ο αλγόριθµος τερµατίζει βάση 

και του κριτηρίου ποιότητας, και δεν σταµατά µόνο µε το όριο του πλήθους των 

γενεών, πράγµα που δείχνει πως λειτουργεί ικανοποιητικά.  

  Με πειραµατισµό του παραπάνω σετ µεγεθών (address, population,…) µπορούµε να 

πετύχουµε καλύτερη απόδοση του συστήµατος. Για παράδειγµα η αύξηση του 

πληθυσµού δίνει την δυνατότητα µεγαλύτερης διερεύνησης του χώρου λύσεων και 

συνεπώς γρηγορότερη σύγκλιση.    
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ΥΛΟΠΟΙΗΣΗ ΣΥΝΘΕΤΟΥ CLASSIFIER SYSTEM 

 

ΣΚΟΠΟΣ 
 
   Αντικείµενο αυτού του κεφαλαίου είναι η θεωρητική περιγραφή του δευτέρου 

µέρους αυτής της εργασίας.  

   Στο προηγούµενο κεφάλαιο αναπτύχθηκε ένα απλοϊκό µοντέλο ενός Classifier 

συστήµατος για την εκµάθηση της συνάρτησης εισόδου εξόδου ενός ψηφιακού 

πολυπλέκτη. Η έλλειψη όµως του «Συστήµατος Καταµερισµού Βαθµών» µας 

οδήγησε στο να προσοµοιώσουµε ένα σύστηµα όχι και τόσο ρεαλιστικό. Για αυτόν το 

λόγο θα αυξήσουµε την πολυπλοκότητα και θα εντάξουµε τον «Bucket Brigade» στο 

σύστηµα µας για ώστε να δούµε µια πιο ολοκληρωµένη µορφή της εκµάθησης ενός 

Classifier System.  

 

ΠΕΡΙΓΡΑΦΗ ΤΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ 

 
   Εντάσσοντας λοιπόν τον «Bucket Brigade» αλλάζει όλη η δοµή του προγράµµατος. 

Ενώ στην προηγούµενη εφαρµογή κάθε άτοµο-λύση του συστήµατος αποτελούνταν 

από ένα σετ κανόνων  (µε γνωστό τον αριθµό των βέλτιστων κανόνων εξαρχής), εδώ 

κάθε άτοµο-λύση είναι µια ξεχωριστή οντότητα-κανόνας (-condition-:-action-). Ο 

πολυπλέκτης που χρησιµοποιήθηκε ήταν ο 4 σε 1 µε 64 δυνατούς συνδυασµούς 

εισόδου.  

   Αρχικά στο πρόγραµµα παράγεται µια τυχαία είσοδος (περιβάλλον) από το σύνολο 

των 64 διαφορετικών εισόδων. Έπειτα αυτή η είσοδος ελέγχεται  πόσα και ποια 

άτοµα του πληθυσµού (Classifier Store) διέγειρε. Η διαδικασία µέχρι εδώ αποτελεί 

την “ραχοκοκαλιά” του συστήµατος µας και ονοµάζεται «Performance System». 

Έπειτα ακολουθεί άλλη µια θεµελιακή διαδικασία, ο αλγόριθµος «Bucket Brigade».   

Τα διεγερµένα άτοµα συναγωνίζονται µεταξύ τους µε την προσφορά ενός ποσού από 

την δύναµη τους για το ποιο θα είναι αυτό που θα εκπέµψει το µήνυµα του. Το 

προσφερόµενο ποσό υπολογίζεται από µια γραµµική σχέση της δύναµης και του 

συντελεστή προσφοράς. Εδώ φαίνεται ότι κάθε άτοµο έχει την δική του δύναµη που 

αποτελεί την ποιότητα ενός ατόµου βάση της οποίας επιλέγεται για αναπαραγωγή. Το 

επικρατέστερο άτοµο (αυτό που πρόσφερε το µεγαλύτερο ποσό) ενεργοποιείται και 

αποστέλλει στην έξοδο το µήνυµα του. Το επόµενο βήµα είναι η επιβράβευση του 
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ατόµου που ενεργοποιήθηκε µόνο όµως στην περίπτωση που το µήνυµα που 

παράχθηκε ταιριάζει µε την σωστή έξοδο της αντίστοιχης εισόδου η οποία 

ενεργοποίησε το άτοµο. Για να µην αυξηθεί όµως υπέρµετρα η δύναµη των κανόνων 

εφαρµόζονται και φόροι που µειώνουν την δύναµη και βοηθούν στο να διακριθούν οι 

πιο σωστοί κανόνες. Η διαδικασία που περιγράφηκε µέχρι στιγµής καλείται 

“iteration”. Αν τώρα εκτελέσουµε ένα µεγάλο πλήθος iterations θα βαθµολογήσουµε 

σωστά όλους τους κανόνες για όλες τις εισόδους. Αυτός είναι και ο αλγόριθµος του 

Bucket Brigade. 

   Συνέχεια έχει ο Γενετικός Αλγόριθµος που εισάγει νέα πληροφορία στο σύστηµα 

µας. Κάθε φορά παράγονται δύο απόγονοι µέσω της διασταύρωσης (Crossover) και 

της µετάλλαξης (Mutation), οι γονείς των οποίων επιλέγονται βάση της µεθόδου 

Roulette Wheel και σύµφωνα µε την ποιότητα τους (δύναµη κανόνα). Έπειτα τα 

άτοµα αυτά παίρνουν την θέση των πιο «αδύναµων» κανόνων. Εφόσον 

αντικαθιστώνται λιγότερα άτοµα από το συνολικό πλήθος των ατόµων του 

πληθυσµού αναφερόµαστε σε Αντικατάσταση Σταθερής Κατάστασης. Τα χειρότερα 

ποιοτικά άτοµα αντικαθιστώνται άµεσα από τους απογόνους χωρίς να χρειάζεται να  

χρησιµοποιηθεί και δεύτερος πληθυσµός που να κρατά τους απογόνους. 

    Κι εδώ το αλφάβητο για τη συνθήκη και το µήνυµα είναι {0,1,#} και {0,1} 

αντίστοιχα. Έτσι ελέγχεται στην µετάλλαξη που ανήκει η θέση του προς µετάλλαξη 

στοιχείου ή στοιχείων (bits) , και αν ανήκει στη συνθήκη ή το µήνυµα µεταλλάσσεται 

βάση του αντίστοιχου αλφάβητου.  

   Η διαδικασία που ορίζεται από την επιλογή των γονέων µέχρι την αντικατάσταση 

του χειρότερου αυτών, ονοµάζεται iteration του ΓΑ. 

   Ο ΓΑ εκτελείται µια φορά µετά από τα iteration του ΒΒ. Αν επαναληφθούν οι δύο 

αυτές διαδικασίες µέσα σε µια επαναληπτική ρουτίνα, το πρόγραµµα θα οδηγηθεί στο 

να παραχθούν κανόνες µε µεγάλη δύναµη που θα ταιριάζουν µε τις εισόδους του 

περιβάλλοντος και θα παράγουν τα σωστά µηνύµατα. 

   Η εφαρµογή τερµατίζει αφού συµπληρωθεί το συνολικό πλήθος των iterations που 

έθεσε ο χρήστης σαν κριτήριο. 
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   Για να φανεί πόσο αποδοτικό είναι το Classifier System που παράχθηκε 

εφαρµόζονται και  64 διαφορετικοί συνδυασµοί εισόδων και υπολογίζεται πόσοι από 

αυτούς ταίριαξαν σωστά µε τους εξελιγµένους κανόνες. 

 

 

ΟΘΟΝΕΣ ΤΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ 

 

Η Κύρια οθόνη του προγράµµατος 

 
   Το παρακάτω σχήµα αποτελεί την φόρµα του Complex Classifier System: 
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   Παρατηρούνται τα εξής Components: 
 
StringGrid4 (Πάνω ∆εξιά): Σε αυτό εµφανίζεται ο αρχικός παραγόµενος πληθυσµός.                               

StringGrid5 (Πάνω Αριστερά): Εδώ εµφανίζονται οι δυνατοί συνδυασµοί εισόδων  

                                                    µε τις αντίστοιχες εξόδους.  

StringGrid6 (Κάτω Αριστερά): Εδώ εµφανίζονται διάφορες σηµαντικοί παράµετροι                                 

                                                   κατά την διάρκεια της εκτέλεσης. 

StringGrid7 (Κάτω ∆εξιά): Εδώ εµφανίζονται οι ενεργοί κανόνες σε κάθε iteration.  

RUN Button: Ξεκινά την εξέλιξη του Classifier System.   

STOP Button: Σταµατά ανά πάσα στιγµή την διαδικασία. 

Quit Label: Τερµατισµός της εφαρµογής. 

Labels (Population, Total Iteration, Crossover Probability, Mutation 

Probability, Bid Coefficient, Reward): ∆είχνουν τις τιµές που έχουν οριστεί από τον  

                                                                 χρήστη. 

Main Menu: Εµφανίζει τις επιλογές του προγράµµατος που είναι δυνατές για τον  

                      χρήστη. 

Status Bar: ∆είχνει την κατάσταση στην οποία βρίσκεται το πρόγραµµα. 

 

MAIN MENU 
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1. FILE 
 
 

 
 

File->Start: Ξεκινά την εξέλιξη του Classifier System. 

File->Default FormSize: Επανακαθορισµός του αρχικού µεγέθους της φόρµας. 

File->Root Menu: Επιστροφή στην αρχική φόρµα. 

File->Exit: Τερµατισµός εφαρµογής. 

 

2. INITIAL 

 

 
 

Initial->Parameters: Εµφανίζει την φόρµα Initial. 

Initial->Tax Parameters: Εµφανίζει την φόρµα Taxes. 

 

3. HELP 

 

 
 

Help-> CCS Help: Εµφανίζει το Help της εφαρµογής. 
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Help-> About: Εµφανίζει την φόρµα About. 

 

Η Οθόνη Αρχικοποίησης Τιµών INITIAL 

 

 

   Αποτελείται από τα εξής Components: 

Population Edit: Εδώ εισάγετε το πλήθος των κανόνων (Population of Classifier  

                            Store). 

Iteration Edit: Εδώ εισάγετε το πλήθος των επαναλήψεων σε κάθε εκτέλεση του   

                         ΒΒ.    

Total Iteration Edit: Εδώ εισάγετε το συνολικό πλήθος των εκτελέσεων του ΒΒ µαζί  

                                   µε τον ΓΑ. ∆ηλαδή το συνολικό πλήθος των iterations.  

Crossover Probability Edit: Εδώ εισάγετε η πιθανότητα διασταύρωσης.  

Mutation Probability Edit: Εδώ εισάγετε η πιθανότητα µετάλλαξης. 

Coefficient Bid Edit: Εδώ εισάγετε ο συντελεστής Προσφοράς. 

Reward Bid Edit: Εδώ εισάγετε η τιµή της επιβράβευσης για τους ενεργούς κανόνες  

                              που παρήγαγαν σωστά µηνύµατα.  

No of Offspring Edit: Εδώ εισάγετε η τιµή του αριθµού των απογόνων που  

                                    δηµιουργούνται σε κάθε εκτέλεση του ΓΑ. 
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Noise Percent Edit: Εδώ εισάγετε η τιµή του ποσοστού θορύβου που χρησιµο-  

                                  ποιείται για τον προσδιορισµό του επικρατέστερου  

                                  κανόνα.  

   Τα παραπάνω µεγέθη έχουν προκαθορισµένες τιµές. Βέβαια ο χρήστης µπορεί ανά 

πάσα στιγµή να τις αλλάξει. Στην περίπτωση που έστω µία τιµή δεν έχει καθοριστεί ή 

είναι µηδέν η εφαρµογή δεν θα µπορέσει να εκτελεστεί πατώντας RUN ή File->Start 

και θα µας ειδοποιήσει µε αντίστοιχο µήνυµα.  

       

Η Οθόνη Αρχικοποίησης Φόρων 

 

 
 

Lifetax Edit: Εδώ εισάγετε η τιµή της παραµέτρου για την φορολογία όλων των  

                     κανόνων. 

Bidtax Edit : Εδώ εισάγετε η τιµή της παραµέτρου για την φορολογία µόνο των  

                      ενεργοποιηµένων κανόνων. 

   Τα παραπάνω µεγέθη έχουν προκαθορισµένες τιµές , αρκεί να επιλεγούν µια φορά 

στην αρχή. Βέβαια ο χρήστης µπορεί ανά πάσα στιγµή να τις αλλάξει. Στην 

περίπτωση που µόνο η µεταβλητή BIDTAX είναι µηδέν η εφαρµογή δεν θα µπορέσει 

να εκτελεστεί πατώντας RUN ή File->Start και θα µας ειδοποιήσει µε αντίστοιχο 

µήνυµα.  

 

   Οι οθόνες που αφορούν την φόρµα About αλλά και την εισαγωγική φόρµα έχουν 

δηλωθεί στο αντίστοιχο κεφάλαιο του SCS και εφόσον είναι κοινές δεν θα  

ξαναδηλωθούν στο σηµείο αυτό. Επίσης ισχύουν τα ίδια µηνύµατα λάθους που 

εµφανίζονται κατά την εκτέλεση του προγράµµατος. 
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Απόδοση του προγράµµατος 

 

   Ακολουθεί ένα πείραµα που δείχνει την αποτελεσµατικότητα του προγράµµατος. 

Για τον σκοπό αυτό έγινε εκτέλεση του προγράµµατος µε τα παρακάτω δεδοµένα: 

 

Population = 100 

Iterations =  1000 

Total Iterations 100 

Crossover Probability = 1,0 

Mutation Probability = 0,03 

Bid Coefficient = 0,1 

Reward = 30 

New Offsprings = 5 

Noise = 10% 

 

Ο παρακάτω πίνακας δείχνει τα αποτελέσµατα της εκτέλεσης για πλήθος 10 φορών: 

 

a/a Αρχική 
Ποιότητα 

Καλύτερη 
Ποιότητα 

Τελική 
Ποιότητα 

1 45 61 61 
2 39 60 60 
3 43 63 63 
4 40 60 60 
5 36 62 62 
6 36 63 63 
7 33 63 63 
8 39 63 59 
9 40 64 62 
10 33 59 56 

 

   Η αποδοτικότητα του συστήµατος είναι εµφανής, εφόσον όπως παρατηρείτε σε 

κάθε εκτέλεση ο αλγόριθµος του ΒΒ µε τον καθορισµό των δυνάµεων των κανόνων 

µαζί µε την γενετική εξέλιξη αυτών από τον ΓΑ, καταφέρνουν να επιτύχουν 

αποδόσεις που ξεκινάνε από µια µέτρια τιµή και φτάνουν σε αρκετά καλές 

προσεγγίσεις  του βέλτιστου ή ακόµη και στο βέλτιστο. Ακόµη λόγω του ότι δεν 

υπάρχει ελιτισµός στο σύστηµα, η µέγιστη τιµή της αποδοτικότητας µπορεί να 

εµφανιστεί και στις ενδιάµεσες γενιές κι όχι απαραίτητα στην τελική. Αυτό φαίνεται 
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στις στήλες της καλύτερης ποιότητας και της τελικής ποιότητας, όπου οι τιµές της 

πρώτης είναι πάντα µεγαλύτερες ή ίσες της δεύτερης.   

    Με πειραµατισµό του παραπάνω σετ µεγεθών (population, iteration, reward, …) 

µπορούµε να πετύχουµε καλύτερες αποδόσεις του συστήµατος. Για παράδειγµα η 

αύξηση του πληθυσµού δίνει την δυνατότητα µεγαλύτερης διερεύνησης του χώρου 

λύσεων και συνεπώς γρηγορότερη σύγκλιση.  
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Ο ΠΗΓΑΙΟΣ ΚΩ∆ΙΚΑΣ ΤΟΥ SCS 

 

 

ΤΕΧΝΙΚΗ ΠΕΡΙΓΡΑΦΗ 

   

   Σαν πρώτο βήµα λοιπόν όπως αναφέρθηκε και στο κεφάλαιο των γενετικών 

αλγορίθµων ήταν η παραγωγή του αρχικού πληθυσµού. Κάθε άτοµο αποτελείται από 

ένα σετ κανόνων-µηνυµάτων. Το σετ για τον πολυπλέκτη 4 σε 1 είναι ένα σύνολο 

από 8 Classifiers, ενώ για τον  8 σε 1 είναι 16. Ο τύπος µεταβλητής που 

χρησιµοποιείται για κάθε Classifier είναι τύπου δοµής η οποία ονοµάζεται «classif» 

και έχει την εξής µορφή: 

 

typedef struct             //classif struct 
{ 
      rules rule[N_MAX]; 
      AnsiString genotype; 
      double fit; 
}classif;     
 

   Κάθε άτοµο λοιπόν αποτελείται από έναν πίνακα Ν_MAX στοιχείων, µε κάθε 

στοιχείο να είναι µια δοµή τύπου rules. Για τον πολυπλέκτη 4 σε 1 χρησιµοποιούνται 

µόνο 8 στοιχεία σε κάθε δοµή (Ν=8), ενώ για τον πολυπλέκτη 8 σε 1 

χρησιµοποιούνται 16 όσοι δηλαδή είναι και οι βέλτιστοι κανόνες σε κάθε περίπτωση.   

Η τελευταία δοµή έχει δηλωθεί πιο πριν για να µπορεί να χρησιµοποιηθεί στο σηµείο 

αυτό. Ο ορισµός της είναι ο ακόλουθος: 

 

typedef struct              //rule struct uses in classif struct 
{ 
      AnsiString condition; 
      AnsiString action; 
}rules;   
 

   Εδώ φαίνεται και η µορφή ενός κανόνα όπως περιγράφηκε στο πρώτο κεφάλαιο 

αφού η δοµή αυτή περιλαµβάνει αλφαριθµητικές µεταβλητές, µία για την συνθήκη 

(condition) και µία για το µήνυµα (action). Έτσι αν είχαµε ένα άτοµο µε όνοµα 

classname, θα αναφερόµασταν στο condition ως εξής: 
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classname.rule.condition 

   Συνεχίζοντας λοιπόν παρατηρούµε ακόµη µια αλφαριθµητική µεταβλητή, την 

genotype, η τιµή της οποίας είναι το αλφαριθµητικό άθροισµα όλων των κανόνων του 

ατόµου. ∆ηλαδή είναι µια ακολουθία από L bits 

L= Ν (κανόνες)×  (condition.Length () + action.Length ())   

   Τέλος βλέπουµε και την µεταβλητή fit που είναι τύπου double και δηλώνει την 

ποιότητα κάθε ατόµου σε σχέση µε το περιβάλλον. Η τιµή αυτή πηγάζει από την 

συνάρτηση ποιότητας που στο πρόγραµµα µας είναι η συνάρτηση match(). Βλέπουµε 

ότι κάθε κανόνας δεν έχει µια τιµή που να δηλώνει την δύναµη του έτσι η fit που 

αντιστοιχεί στο σύνολο των κανόνων δηλαδή στο κάθε άτοµο, είναι η µόνη πηγή 

πληροφορίας µέσω της οποίας θα εξελιχθεί το σύστηµα µας.  

   Η αρχική παραγωγή του πληθυσµού γίνεται µέσα σε ένα βρόχο που εκτελείται 

τόσες φορές όσες και ο αριθµός των ατόµων. Το πλήθος των ατόµων καθορίζεται από 

το χρήστη κατά την εκτέλεση του προγράµµατος, πριν ξεκινήσει η εκµάθηση των 

κανόνων. Για µεγάλες τιµές του πλήθους των ατόµων, ο αλγόριθµος συγκλίνει πιο 

γρήγορα όσων αφορά το πλήθος των γενεών εφόσον ερευνά µεγαλύτερο εύρος του 

χώρου λύσεων όµως απαιτεί µεγαλύτερη χρονική διάρκεια και άρα υπολογιστική 

ισχύς. Για µικρές τιµές του αριθµού των ατόµων η κάθε γενιά διαδέχεται γρήγορα την 

άλλη χρονικά αλλά αργεί να συγκλίνει φτάνοντας  σε µεγάλο αριθµό γενεών. Έπειτα 

αρχικοποιούνται και άλλα στοιχεία του προγράµµατος, όπως ο πίνακας 

αλφαριθµητικών detc[] που περιέχει τις εισόδους από το περιβάλλον (detectors) και 

που κάθε στοιχείο του λαµβάνει τιµή από την εκτέλεση της συνάρτησης 

IntToBinary(). Το πλήθος των στοιχείων του πίνακα για κάθε πολυπλέκτη ισούται µε: 

2address + data

   Εποµένως για τον πολυπλέκτη 4 σε 1 θα έχουµε πλήθος στοιχείων 64 (address = 2 

και data = 4), και για τον πολυπλέκτη 8 σε 1 το πλήθος αυτό θα είναι 2048 (address=3 

και data = 8). Αυτό που κάνει η τελευταία συνάρτηση είναι να παίρνει σαν όρισµα 

έναν ακέραιο (τον δείκτη της θέσης του στοιχείου µέσα στον πίνακα) και να τον 

µετατρέπει στην  δυαδική του µορφή. Το σώµα της συνάρτηση είναι το εξής: 
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AnsiString IntToBinary(int x) 
{                                     
      int i; 
      int mask = pow(2,(BITS-1)); 
      AnsiString s=""; 
      for (i=0;i<BITS;i++) 
      { 
            if ( (x & mask) > 0) {s+="1";} 
            else                 {s+="0";} 
            mask=mask >> 1; 
      } 
      return s; 
} 

   Η συνάρτηση αυτή χρησιµοποιεί την δυαδική µορφή του ακεραίου mask και την 

δυαδική µορφή του ορίσµατος. Ελέγχει κάθε θέση bit σύµφωνα µε την λογική της 

πύλης AND και δηµιουργεί κατάλληλα µια αλφαριθµητική τιµή η οποία  

επιστρέφεται σαν τιµή στην αντίστοιχη θέση του πίνακα detc[]. Οι δυνατές τιµές 

εισόδου είναι 000000…111111 για τον 4_1  και  00000000000…11111111111 για 

τον 8_1. 

   Όµοια για τον πίνακα ακεραίων out[] που περιλαµβάνει σαν τιµές τις σωστές 

εξόδους (effectors) για κάθε είσοδο. Κάθε στοιχείο του πίνακα παίρνει τιµή από την 

εκτέλεση της συνάρτησης OutputMsg(). Σαν ορίσµατα εισάγονται οι τιµές των 

θέσεων του πίνακα detc[] και παράγονται οι αντίστοιχες έξοδοι. Άρα οι δύο 

τελευταίες συναρτήσεις εκτελούνται τον ίδιο αριθµό φορών. Το σώµα της 

OutputMsg() είναι: 

 
int OutputMsg(AnsiString str) 
{ 
         int m; 
         int i,sum; 
         sum=1; 
         for(i=1;i<=address;i++) 
         { 
               if(str[i]=='1') 
                   sum+=1*pow(2,(address-i)); 
               else 
                   sum+=0; 
         } 
         if(str[address+sum]=='0') 
               m=0; 
         else 
               m=1; 
         return m;      } 
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   Στη συνέχεια ακολουθεί η αποτίµηση των λύσεων. Υπεύθυνη για την διαδικασία 

αυτή είναι η συνάρτηση match() (συνάρτηση ποιότητας). Αυτό που κάνει η 

συνάρτηση αυτή είναι να ταιριάζει τις εισόδους του περιβάλλοντος µε τους κανόνες 

κάθε ατόµου. Κάθε φορά που ταιριάζει ένας κανόνας µε µία είσοδο, η δύναµη του 

ατόµου αυξάνεται κατά ένα, όταν βέβαια ταιριάζει και το µήνυµα του 

ενεργοποιηµένου κανόνα µε την σωστή έξοδο που αντιστοιχεί στην είσοδο που 

ενεργοποίησε τον κανόνα . Στην περίπτωση που ενεργοποιούνται πολλοί κανόνες 

ισχύει το επικρατέστερο µήνυµα  από αυτούς. Για παράδειγµα αν ενεργοποιηθούν 

τρεις κανόνες εκ των οποίων οι δύο παράγουν σαν µήνυµα την µονάδα “1” και ο 

τρίτος το µηδέν “0”, τότε επικρατέστερο µήνυµα είναι η µονάδα. Στην περίπτωση 

όµως που ενεργοποιηθούν κανόνες που παράγουν ίσο αριθµό µηνυµάτων µε “0” και 

”1” , τότε επιλέγεται ένα από τα δύο µηνύµατα µε ποσοστό 50% και αν επαληθευθεί 

µε την σωστή έξοδο τότε η δύναµη του ατόµου αυξάνεται κατά 0.5 και όχι κατά 1. 

Αυτό γίνεται γιατί µπορεί σε δύο διαδοχικές κλήσεις της match()το ίδιο άτοµο να 

δώσει την µια φορά σαν έξοδο ‘0’ και την άλλη ‘1’ πράγµα που όπως είναι νοητό δεν 

συµφωνεί µε το επιθυµητό, δηλαδή να µας δώσει και τις δύο φορές την ίδια έξοδο.  

   Παρακάτω φαίνεται το σώµα της match() :  
 
double match(AnsiString detc1[], classif par1, int out1[]) 
{ 
        bool equal; 
        bool eqFL=false;                              //it is true when one==true; 
        int zero,one,i,j,c,eff,x; 
        double fit; 
        AnsiString str; 
 
        fit=0.0; 
        for(c=0;c<T;c++) 
        { 
               str=detc1[c]; 
               x=out1[c]; 
               zero=0; 
               one=0; 
               for(i=0;i<N;i++) 
                { 
                        for(j=1;j<=BITS;j++) 
                        { 
                                if(str[j]==par1.rule[i].condition[j] || par1.rule[i].condition[j]=='#') 
                                   equal=true; 
                                else 
                                { 
                                   equal=false; 
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                                   break; 
                                } 
                        } 
                        if(equal) 
                        { 
                           if(par1.rule[i].action=='1') 
                              one++; 
                           else 
                              zero++; 
                        } 
                } 
                if(one!=0 || zero!=0) 
                { 
                   if(one>zero) 
                      eff=1; 
                   else if(one<zero) 
                      eff=0; 
                   else if(one==zero) 
                   { 
                       if(rnd()<0.5) 
                          eff=0; 
                       else 
                          eff=1; 
                       eqFL=true;     
                   } 
                   if(x==eff && eqFL==false) 
                      fit++; 
                   else if(x==eff && eqFL==true) 
                   { 
                      fit+=0.5; 
                      eqFL=false; 
                   } 
                } 
        } 
        return fit; 
} 
  
   Στη συνέχεια του βασικού προγράµµατος βρίσκεται η εξέλιξη του ΓΑ που 

πραγµατοποιείται µέσα από έναν βρόχο do{}while(). Όπως πλέον γνωρίζουµε η 

επόµενη φάση της εξέλιξης είναι η επιλογή των ατόµων. Για την επιλογή των ατόµων 

χρησιµοποιήθηκε η µέθοδος επιλογής Roulette Wheel (αυτό είναι και το όνοµα της 

αντίστοιχης συνάρτησης) σύµφωνα µε την οποία τα άτοµα επιλέγονται βάση της 

ποιότητας τους. Η συνάρτηση αυτή είναι η παρακάτω: 

int roulettewheel(classif par1[]) 
{ 
        double sum, sumrnd ; 
        int i; 
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        sum=0.0; 
        for(i=0;i<P;i++) 
        { 
                sum+=par1[i].fit; 
        } 
        sumrnd=rnd()*sum; 
        for(i=0,sum=0;i<P;i++) 
        { 
                sum+=par1[i].fit; 
                if (sum>=sumrnd) 
                break; 
        } 
        return i; 
}    
 
   Ακολουθούν οι γενετικοί τελεστές της ∆ιασταύρωσης (συνάρτηση Crossover() ) και 

της µετάλλαξης (συνάρτηση Mutation() ) 

   Η συνάρτηση της διασταύρωσης παίρνει σαν ορίσµατα τα δύο άτοµα που 

επελέγησαν από την RouletteWheel() και τα ανασυνδυάζει. Ο ανασυνδυασµός γίνεται 

µε τις µεταβλητές genotype των δύο ατόµων. Ο αριθµός των σηµείων κοπής είναι και 

αυτός µία παράµετρος που καθορίζεται από τον χρήστη κατά την εκτέλεση του 

προγράµµατος. Βέβαια η συνάρτηση είναι αυτή που καθορίζει ποιες θα είναι οι 

θέσεις των σηµείων κοπής, οι οποίες καθορίζονται µε τυχαίο τρόπο. Άλλο ένα 

πρόβληµα που µπορεί να προκύψει στο σηµείο αυτό, είναι µήπως και η συνάρτηση 

παράγει δύο φορές το ίδιο σηµείο κοπής. Αυτό αποφεύγεται χωρίζοντας τον γονότυπο 

σε τόσα τµήµατα όσα είχε ορίσει ο χρήστης για τα σηµεία κοπής και υπολογίζοντας 

ένα σηµείο για κάθε τµήµα.        

   Για παράδειγµα αν είχαµε τους παρακάτω γονότυπους µε µήκος L bits (όπως 

ορίστηκε στην σελίδα 32): 

Α.genotype= 00000000……..00000000 

B.genotype= 11111111……..11111111 

και ο χρήστης έδινε αριθµό σηµείων κοπής 2 (έστω το πρώτο βρίσκεται µεταξύ του 

5ου και του 6ου bit και το δεύτερο µεταξύ του L-4 και L-3 ) τότε τα παραγόµενα άτοµα 

θα ήταν τα: 

child1.genotype= 00000111……..11110000 

child2.genotype= 11111000……..00001111 

Συνάρτηση Crossover(): 
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classif Crossover(classif s1, classif s2) 
{ 
      int i,j,pos,tmima; 
      classif child; 
      bool chFL=true; 
 
      int L=N*(BITS+ABITS);           //megethos genotype 
 
      tmima=(int)(L/points); 
 
      j=1; 
      child.genotype=""; 
      for(i=0;i<points;i++) 
      { 
         pos=i*tmima + random(tmima) + 1; 
         while(j<=pos) 
         { 
            if(chFL==true) 
               child.genotype+=s1.genotype[j]; 
            else 
               child.genotype+=s2.genotype[j]; 
            j++; 
         } 
         if(chFL==true) {chFL=false;} 
         else           {chFL=true;} 
      } 
      while(j<=L) 
      { 
            if(chFL==true) 
               child.genotype+=s1.genotype[j]; 
            else 
               child.genotype+=s2.genotype[j]; 
            j++; 
      } 
      return child; 
}  

  Όπως φαίνεται και από την συνάρτηση, επιστρέφεται µόνο ένα άτοµο. ∆εν έχει 

σηµασία µε ποια σειρά καθορίζεται το άτοµο που θα επιστραφεί (αν δηλαδή παίρνει 

στοιχεία πρώτα από το s1 ή πρώτα από το s2) αφού και οι δύο περιπτώσεις 

παράγονται τυχαία. Η σειρά µε την οποία ξεκινάει η αντιγραφή καθορίζεται από την 

µεταβλητή chFL, όπου αν αρχικοποιείται µε την τιµή true θα πάρει στοιχεία πρώτα 

από το s1, αλλιώς αν είναι false θα πάρει πρώτα από το s2. Η αποτίµηση του είναι 

αυτή που θα δείξει το πόσο κατάλληλο είναι για την εξέλιξη. 

   Αξίζει να σηµειωθεί ότι κατά την αρχική υλοποίηση του προγράµµατος η 

µεταβλητή genotype δεν υπήρχε και η διασταύρωση µεταξύ δύο ατόµων γινόταν 
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µεταξύ των κανόνων. ∆ηλαδή ο απόγονος έπαιρνε τους  κανόνες  του ενός γονέα 

µέχρι το σηµείο κοπής και τους υπόλοιπους από τον άλλον. Η συνάρτηση αυτή 

καλείται βάση κάποιας πιθανότητας CrossProb. Αν τύχει να µην εκτελεστεί η 

Crossover() τότε επιλέγεται  να περάσει στον πληθυσµό των απογόνων pop[] ένας 

από τους δύο γονείς η επιλογή του οποίου γίνεται µε την βοήθεια της συνάρτησης 

βιβλιοθήκης random(). Ο έλεγχος για την πιθανότητα να κληθεί η συνάρτηση γίνεται 

µε την βοήθεια µιας τιµής που βρίσκεται στο διάστηµα [0,1] και που επιστρέφεται 

από µια «βοηθητική» συνάρτηση την rnd() (βλ. Πηγαίο Κώδικα Προγράµµατος –

Unit2).  

   Η µετάλλαξη τώρα πραγµατοποιείται στο παραγόµενο άτοµο είτε αυτό προέκυψε 

από διασταύρωση είτε από “κλωνοποίηση”. Στέλνεται σαν όρισµα το άτοµο-

απόγονος και εσωτερικά στο σώµα της συνάρτησης Mutation() µεταλλάσσεται ο 

γονότυπος του. Η παράµετρος PMUT (mutation probability) θα καθορίσει πόσα bit 

του γονότυπου θα µεταλλαχθούν. Οι δυνατές µεταλλάξεις για το condition είναι οι 

εξής: 

0 → 1  ή  # 

1 → 0  ή  # 

# → 0  ή  1 

 και για το action: 

0 → 1   

1 → 0   

 

   Προγραµµατιστικά αυτό υλοποιήθηκε µε το να ελέγχεται η θέση του κάθε bit και 

αν αυτή είναι ακέραιο πολλαπλάσιο του µήκους του κάθε κανόνα τότε να 

µεταλλάσσεται το action σύµφωνα µε τον πιο πάνω τρόπο αλλιώς να µεταλλάσσεται 

το condition. 

   Συνάρτηση Mutation: 
 
classif Mutation(classif par1) 
{ 
      double point , rest; 
      int j,bits,pos; 
 
      point = PMUT * N * (BITS + ABITS);  // ta simeia pou tha ginei i metalaxi 
      bits = (int)point;                   //to akeraio meros 
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      rest = point - bits;                 //float meros 
      if(rnd() < rest)                    //prob gia na metallaxthei allo ena bit 
            bits++; 
      for(j=0;j<bits;j++) 
     { 
            pos=random(N*(BITS + ABITS)) + 1; 
            if(pos%(BITS + ABITS)==0)              //  gia to mnvuma(action) tha prepei na       
                                                                      //doume an to ypoloipo 
            { 
                 if(par1.genotype[pos]=='0')        // einai 0 kai tha to allaksoume se 0 h 1 
                       par1.genotype[pos]='1'; 
                 else 
                       par1.genotype[pos]='0'; 
              } 
              else 
              { 
                    if(par1.genotype[pos]=='0') 
                           if(rnd()<0.5)   par1.genotype[pos]='1'; 
                           else            par1.genotype[pos]='#'; 
                    else 
                    if(par1.genotype[pos]=='1') 
                           if(rnd()<0.5)   par1.genotype[pos]='0'; 
                           else            par1.genotype[pos]='#'; 
                    else 
                           if(par1.genotype[pos]=='#') 
                                  if(rnd()<0.5)   par1.genotype[pos]='1'; 
                                  else            par1.genotype[pos]='0';   
              } 
     } 
     return par1; 
} 
 
   Στη συνέχεια αφού έχουν διαµορφωθεί οι γονότυποι των απογόνων στον πληθυσµό 

pop[], θα πρέπει να παραχθούν µέσα από την µεταβλητή genotype οι κανόνες στην 

κανονική τους µορφή: 

condition : action  

   Υπάρχει για αυτό η συνάρτηση LineToArray() (Unit2) που παίρνει αυτήν την 

ακολουθία των bits και την µετατρέπει σε ένα σετ ή πίνακα από κανόνες. Έτσι τα 

καινούργια άτοµα µπορούν να αξιολογηθούν και πάλι µέσα από την συνάρτηση 

match(). 

   Υπάρχει και η αντίστροφη συνάρτηση ArrayTοLine() (Unit2) που από το σετ 

κανόνων δηµιουργεί τον ενιαίο γονότυπο αφού όπως είναι κατανοητό χρειάζεται 

στους γενετικούς τελεστές. 
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   Για την γρηγορότερη σύγκλιση του αλγόριθµου εισάγουµε έναν τελεστή 

αναρρίχησης. Χρησιµοποιήθηκε µια παραλλαγή του Swap Bit HCO. Αλλάζει  κάθε 

φορά µόνο ένα bit  ενός τυχαίου κανόνα από κάποιο άτοµο µε τα υπόλοιπα σύµβολα 

του αλφάβητου ( 0, 1, #  αν πρόκειται για την συνθήκη του κανόνα, και 0 , 1  για το 

µήνυµα) και ελέγχεται η ποιότητα του τροποποιηµένου κανόνα. Αν αυτή είναι 

καλύτερη από την αρχική τότε θα υιοθετηθεί ο καινούριος κανόνας,  αλλιώς αυτός  

θα ακυρωθεί και θα επικρατήσει ο αρχικός. Η αντίστοιχη συνάρτηση είναι η 

HillClimber(). 

   Η διαδικασία που περιγράφηκε από το σηµείο της επιλογής των γονέων-ατόµων 

µέχρι εδώ επαναλαµβάνεται ώσπου να γεµίσει ο πληθυσµός των απογόνων πλην της 

τελευταίας θέσης η οποία κρατείται για να καταχωρηθεί το άτοµο από τον πληθυσµό 

των γονέων par[] µε την καλύτερη ποιότητα. 

   Η γενιά ολοκληρώνεται µε την εύρεση του πιο βέλτιστου κανόνα και την εισαγωγή 

του στην τελευταία θέση του πληθυσµού των απογόνων (Ελιτισµός): 

 

//-----------elitism---------------- 

        max=par[0].fit; 
        best=0; 
        for(p=1;p<P;p++) 
        { 
               if(max<par[p].fit) 
              { 
                     max=par[p].fit; 
                     best=p; 
               } 
        } 
    

και την ολική αντικατάσταση του πληθυσµού των γονέων από τον πληθυσµό των 

απογόνων: 

//Oi apofonoi_POP diadexontai toys goneis_PAR 

        for(p=0;p<P;p++) 
        { 
                par[p] = pop[p]; 
        }        
 
   Μέσα στον βρόχο do..while{} υπάρχει ένας µετρητής, ο count που ξεκινάει από το 
µηδέν και αυξάνεται κατά ένα σε κάθε επανάληψη και δηλώνει το πλήθος των 
γενεών.    
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   Τέλος οι συνθήκες τερµατισµού του βρόχου αποτελούν τα κριτήρια τερµατισµού 

και του ΓΑ. 

   Πιο ειδικά για τον τερµατισµό, µέσα στην while() καλείται µια συνάρτηση η 

criterion() , που ελέγχει αν η τιµή της µεταβλητής count και η πιθανότητα του 

καλύτερου ατόµου κάθε γενιάς συµφωνούν µε τα όρια που τέθηκαν από τον  χρήστη 

και ανάλογα επιστρέφει µια true ή false τιµή.    

 
 
 
ΤΑ UNIT ΤΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ 
 
 
 
ΕΙΣΑΓΩΓΙΚΗ ΦΟΡΜΑ 
 
 

   Η εισαγωγική φόρµα της εργασίας αντιστοιχεί στο Unit1 και αποτελείται από τα 

εξής αρχεία: 

• Unit1.cpp 

• Unit1.h 

• Unit1.dfm 

 
 

Κλάση 

 

TEntry: Η κλάση της εισαγωγικής φόρµας. 
 
Όπως φαίνεται αποτελείται από τρία Buttons. 
 

 

Συναρτήσεις-Μέλη 

 

void __fastcall TEntry::QuitClick(TObject *Sender) 

   Quit: Τερµατίζει την εφαρµογή. 

 
void __fastcall TEntry::ButtonSCSClick(TObject *Sender) 
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   Continue to the SCS: Μας εισάγει στο πρόγραµµα του απλού Classifier                                                

συστήµατος.  

 
void __fastcall TEntry::ButtonCCSClick(TObject *Sender)  

   Continue to the CCs: Μας εισάγει στο πρόγραµµα του σύνθετου Classifier                              

συστήµατος.  

 

void __fastcall TEntry::FormCanResize(TObject *Sender, int &NewWidth, 

int &NewHeight, bool &Resize) 

   Κρατάει το Resize=false ώστε να µην αυξοµειώνεται το µέγεθος της φόρµας. 

 

 

ΦΟΡΜΑ ΤΟΥ SCS 
 

 
   Είναι η κύρια φόρµα του προγράµµατος που προσοµοιώνει την συνάρτηση εισόδου 

εξόδου του απλού ψηφιακού πολυπλέκτη χωρίς την χρήση του «Συστήµατος 

Καταµερισµού Βαθµών». 

  

   Η φόρµα αυτή αντιστοιχεί στο Unit2 και αποτελείται από τα εξής αρχεία:   

• Unit2.cpp 

• Unit2.h 

• Unit2.dfm 

 

Κλάση 

 

TSCSMainForm: Η κλάση της κύριας φόρµας. 

 
 
Σταθερές 

 

#define ABITS 1: Σταθερά για τον καθορισµό του µήκους του µηνύµατος.          

#define N_MAX 100: Σταθερά για τον καθορισµό του πλήθους των στοιχείων του  

                                    πίνακα rule[] τα οποία είναι τύπου rules. 
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Μεταβλητές και ∆οµές 

 

typedef struct              //rule struct uses in classif struct 

{ 

   AnsiString condition; 

   AnsiString action; 

}rules; 

   ∆οµή τύπου rules.  

 

typedef struct             //classif struct 

{ 

    rules rule[N_MAX];   // N_MAX constant  = 100 

   AnsiString genotype; 

   double fit; 

}classif; 

   ∆οµή τύπου classif.  

 

TEdit *GenEdit :  

   Σε αυτό το Edit Box o χρήστης εισάγει το όριο του κριτηρίου των γενεών. 

TEdit *FitEdit :  

   Σε αυτό το Edit Box o χρήστης εισάγει το όριο του κριτηρίου  ποιότητας. 

int address : 

   Μεταβλητή που ορίζεται από τον χρήστη και δηλώνει το µέγεθος του address των 

κανόνων. 

int P :  

   Μεταβλητή που ορίζεται από τον χρήστη και δηλώνει το πλήθος του Classifier 

Store. 

int points : 

   Μεταβλητή που ορίζεται από τον χρήστη και δηλώνει τον αριθµό των σηµείων 

κοπής. 

double CROSSPROB : 

   Ορίζεται από τον χρήστη και δηλώνει την πιθανότητα διασταύρωσης. 

double PMUT :  
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   Ορίζεται από τον χρήστη και δηλώνει την πιθανότητα µετάλλαξης. 

int count :  

   Μετρητής που κρατάει το πλήθος των γενεών. 

int data :  

   Μεταβλητή που δηλώνει το µέγεθος του data των κανόνων. Εξαρτάται από                 

το address. 

int BITS :  

   Μέγεθος του Condition. Εξαρτάται από τα address και data. 

int T :  

   Πλήθος δυνατών συνδυασµών εισόδου-εξόδου. Εξαρτάται από το BITS. 

int N : 

    Πλήθος βέλτιστων κανόνων σε κάθε άτοµο. Εξαρτάται από το data. 

bool genFL :  

   Λογική µεταβλητή για τον καθορισµό του κριτηρίου τερµατισµού βάση                     

του αριθµού των γενεών. 

bool fitFL : 

   Λογική µεταβλητή για τον καθορισµό του κριτηρίου τερµατισµού βάση                      

της ποιότητας. 

bool genfitFL :  

   Λογική µεταβλητή για τον καθορισµό του κριτηρίου τερµατισµού βάση του 

συνδυασµού των δύο παραπάνω.               

bool stopFL : 

   Λογική µεταβλητή για την διακοπή όλης της εφαρµογής. 

 

   Όλες οι παραπάνω µεταβλητές είναι GLOBAL Μεταβλητές. 

 

Συναρτήσεις 

 

double rnd(void) 

   Παράγει έναν τυχαίο αριθµό στο διάστηµα [0,1]. 

 
AnsiString IntToBinary(int x) 

   Παίρνει σαν όρισµα έναν αριθµό µεταξύ του ‘0’ και του µέγιστου των δυνατών 

συνδυασµών εισόδων-εξόδων και επιστρέφει την δυαδική του µορφή. 
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bool criterion(classif parBest, int gen, double fitness) 

   Παίρνει σαν ορίσµατα το καλύτερο άτοµο,  τον µέγιστο αριθµό γενεών και την 

ποιότητα που όρισε ο χρήστης και ελέγχει αν ικανοποιούνται τα κριτήρια 

τερµατισµού. 

 
Int OutputMsg(AnsiString str)    

   Παίρνει σαν όρισµα την δυαδική µορφή µιας εισόδου και επιστρέφει την σωστή 

έξοδο για αυτήν την είσοδο. 

 
AnsiString ArrayToLine(classif par1) 

   Παίρνει σαν όρισµα ένα άτοµο και από τον πίνακα των κανόνων παράγει και 

επιστρέφει τον ενιαίο γονότυπο. 

 
classif LineToArray(classif par1) 

   Εκτελεί την αντίστροφη εργασία από την παραπάνω συνάρτηση. Από τον γονότυπο 

επανακαθορίζει το σετ κανόνων.  

 
double match(AnsiString detc1[], classif par1, int out1[])  // ΓΑ 

   Είναι η συνάρτηση ποιότητας (fitness function). Παίρνει σαν ορίσµατα ένα στοιχείο 

του πληθυσµού , τον πίνακα των εισόδων και τον πίνακα των εξόδων. Επιστρέφει την 

ποιότητα του κάθε ατόµου. 

 
int roulettewheel(classif par1[])  // ΓΑ 

   Συνάρτηση για την επιλογή γονέων.  

 
classif Crossover(classif s1, classif s2) 

   Συνάρτηση ανασυνδυασµού-διασταύρωσης γονέων. 

 
classif Mutation(classif par1)  // ΓΑ 

   Συνάρτηση µετάλλαξης παραγόµενου ατόµου είτε από διασταύρωση είτε από 

“κλωνοποίηση”. 

 
classif HillCLimber(classif par1,AnsiString detc[],int out[])  // ΓΑ 

   Συνάρτηση του τελεστή αναρρίχησης. Αποτελεί µια παραλλαγή του «SWAP BIT 

HCO». 
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Συναρτήσεις-Μέλη 

 

void __fastcall TSCSMainForm::FormClose(TObject *Sender, TCloseAction 

&Action) 

   Είναι υπεύθυνη για τον τερµατισµό όλης της εφαρµογής. 

 

void __fastcall TSCSMainForm::Button1Click(TObject *Sender)  

   Είναι η βασική συνάρτηση µέσα στην οποία γίνονται όλες οι διεργασίες: 

 ∆ηµιουργία δυναµικού πληθυσµού γονέων και απογόνων 

      classif * par, * pop; 

      par=new classif[P]; 

      pop=new classif[P]; 

 
 ∆ηµιουργία δυναµικών πινάκων για τις εισόδους – εξόδους 

 
      int* out; 

      out=new int[T]; 

      AnsiString* detc; 

      detc=new AnsiString[T]; 

  

  Κλήσεις όλων των παραπάνω συναρτήσεων που είναι υπεύθυνες για την γενετική 

εξέλιξη των ατόµων καθώς και κάποιων βοηθητικών συναρτήσεων (π.χ. rnd() , 

LineToArray(), …). 

 

void __fastcall TSCSMainForm::FormCreate(TObject *Sender) 

   Καλείται µε το που δηµιουργείται η φόρµα SCSMainForm.  

 
void __fastcall TSCSMainForm::Exit1Click(TObject *Sender) 

   Τερµατίζει την εφαρµογή µέσα από το Main Menu. 

 
void __fastcall TSCSMainForm::LimGenClick(TObject *Sender) 

   Προσδιορίζει σαν κριτήριο τερµατισµού τον αριθµό των γενεών και εµφανίζει το 

αντίστοιχο Edit Box για την εισαγωγή του από τον χρήστη. 
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void __fastcall TSCSMainForm::LimFitClick(TObject *Sender) 

   Προσδιορίζει σαν κριτήριο τερµατισµού την επιθυµητή ποιότητα των ατόµων και 

εµφανίζει το αντίστοιχο Edit Box για την εισαγωγή της από τον χρήστη. 

 
void __fastcall TSCSMainForm::LimGenFitClick(TObject *Sender) 

   Συνδυάζει ταυτόχρονα τα δύο παραπάνω κριτήρια και εµφανίζει και τα δύο Edit 

Boxes. 

 
void __fastcall TSCSMainForm::SCSHelp1Click(TObject *Sender) 

   Εµφανίζει το Help της εφαρµογής. 

 
void __fastcall TSCSMainForm::About1Click(TObject *Sender) 

   Εκτελείται όταν πατηθεί το Help  About από το Main Menu και εµφανίζει την 

φόρµα About. 

 
void __fastcall TSCSMainForm::DefaultFormSize1Click(TObject *Sender) 

   Εκτελείται όταν πατηθεί το File  Default FormSize από το Main Menu και 

επανακαθορίζει την φόρµα στην αρχική της µορφή. 

 
void __fastcall TSCSMainForm::Variables1Click(TObject *Sender) 

   Εκτελείται όταν πατηθεί το Initial  Parameters και εµφανίζει την φόρµα Initial για 

την εισαγωγή δεδοµένων από τον χρήστη. Επίσης αρχικοποιούνται και τα StringGrid 

του προγράµµατος. 

 
void __fastcall TSCSMainForm::StopClick(TObject *Sender) 

   Το πάτηµα του πλήκτρου Stop που αντιστοιχεί σε αυτήν την συνάρτηση προκαλεί 

την διακοπή της εξέλιξης του προγράµµατος. 

 
void __fastcall TSCSMainForm::RootMenu1Click(TObject *Sender) 

   Μας επιστρέφει στην εισαγωγική φόρµα. Βρίσκεται µέσα στην Main Menu   

File  Root Menu. 

 
void __fastcall TSCSMainForm::QuitClick(TObject *Sender) 

   Προκαλεί την έξοδο από το πρόγραµµα. 
 
void __fastcall TSCSMainForm::GenEditKeyPress(TObject *Sender, char 

&Key) 
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   Καλείται όταν εισάγουµε τα δεδοµένα στο GenEdit Box και ελέγχει αν έχουν δοθεί 

σωστά. Αν για παράδειγµα πατηθεί χαρακτήρας αντί αριθµού τότε εµφανίζεται 

αντίστοιχο µήνυµα που µας ειδοποιεί ότι πρέπει να επανακαθορίσουµε την τιµή του 

στοιχείου.  

 

void __fastcall TSCSMainForm::FitEditKeyPress(TObject *Sender, char &Key)  

   Όµοια µε το GenEdit και το FitEdit καλείται για να ελέγξει αν έχει δοθεί αριθµός 

και όχι χαρακτήρας. 

   Οι δύο παραπάνω συναρτήσεις-µέλη αναφέρονται στο κριτήριο τερµατισµού και τα 

δύο Edit Boxes καθορίζουν τα όρια του αριθµού των γενεών και της ποιότητας. Ο 

έλεγχος διευκρινίζει και αν έχουν δοθεί δεκαδικοί αντί για ακέραιοι που είναι το 

απαιτούµενο.    

 

 

ΦΟΡΜΑ ΑΡΧΙΚΟΠΟΙΗΣΗΣ ΤΙΜΩΝ INITIAL 

 
   

 Είναι µία Modal φόρµα που εµφανίζεται για να εισάγουµε τα αρχικά στοιχεία. 

Αποτελείται από 5 Edit Boxes , 5 Labels και 2 BitBtns. 

 
Η φόρµα αυτή αντιστοιχεί στο Unit5 και αποτελείται από τα εξής αρχεία:   

• Unit5.cpp 

• Unit5.h 

• Unit5.dfm 

 
 
Κλάση 

 
TInitial: Η κλάση της φόρµας. 
 
 
Συναρτήσεις-Μέλη 
 
 
void __fastcall TInitial::FormCanResize(TObject *Sender, int &NewWidth, 

int &NewHeight, bool &Resize) 

   Καθορίζει ότι το µέγεθος της φόρµας είναι αµετάβλητο (Resize = false).  
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void __fastcall TInitial::AddrEditKeyPress(TObject *Sender, char &Key) 

   Καλείται όταν εισάγουµε τα δεδοµένα στο AddrEdit Box και ελέγχει αν έχουν δοθεί 

σωστά. Αν για παράδειγµα πατηθεί χαρακτήρας αντί αριθµού τότε εµφανίζεται 

αντίστοιχο µήνυµα που µας ειδοποιεί ότι πρέπει να επανακαθορίσουµε την τιµή του 

στοιχείου. 

 
void __fastcall TInitial::PopEditKeyPress(TObject *Sender, char &Key) 

   Όµοια κι εδώ ελέγχεται τι πατήθηκε µέσα στο PopEdit Box και αντίστοιχα είτε 

εκχωρεί την τιµή στο στοιχείο είτε εµφανίζει µήνυµα για τον επανακαθορισµό του 

πληθυσµού.  

 
void __fastcall TInitial::CPointsEditKeyPress(TObject *Sender, char &Key) 

   Όµοια κι εδώ ελέγχεται τι πατήθηκε µέσα στο CPointsEdit Box και αντίστοιχα είτε 

εκχωρεί την τιµή στο στοιχείο είτε εµφανίζει µήνυµα για τον επανακαθορισµό του 

στοιχείου. 

   Οι τρεις αυτές παράµετροι λαµβάνουν µόνο ακέραιους αριθµούς. Έτσι αν πατηθεί 

ακόµη και ο χαρακτήρας ‘,’ εµφανίζεται πάλι το µήνυµα λάθους. 

 
void __fastcall TInitial::CrEditKeyPress(TObject *Sender, char &Key)  

   Όµοια ελέγχεται τι πληκτρολόγησε ο χρήστης του προγράµµατος για την 

πιθανότητα ∆ιασταύρωσης. Ο χρήστης µπορεί να πληκτρολογήσει και πραγµατικό 

αριθµό. Επίσης ελέγχει αν αντί του χαρακτήρα  ‘,’  που είναι για τους πραγµατικούς 

πατηθεί ο χαρακτήρας ‘.’ και τον αλλάζει αυτόµατα στον ‘,’ . 

 
void __fastcall TInitial::MEditKeyPress(TObject *Sender, char &Key) 

   Όµοια ελέγχεται τι πληκτρολόγησε ο χρήστης του προγράµµατος για την 

πιθανότητα µετάλλαξης. Ο χρήστης µπορεί να πληκτρολογήσει και πραγµατικό 

αριθµό. Επίσης ελέγχει αν αντί του χαρακτήρα  ‘,’  που είναι για τους πραγµατικούς 

πατηθεί ο χαρακτήρας ‘.’ και τον αλλάζει αυτόµατα στον ‘,’ . 

    

 
ΦΟΡΜΑ ABOUT 
 
   

 Είναι µία Modal φόρµα που περιέχει πληροφορίες για τον συγγραφέα και το 

πρόγραµµα υλοποίησης της όλης εργασίας. 
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 Η φόρµα αυτή αντιστοιχεί στο Unit3 και αποτελείται από τα εξής αρχεία:   

• Unit3.cpp 

• Unit3.h 

• Unit3.dfm 

 
 
Κλάση 

 
TAbout: Η κλάση της modal φόρµας. 
 
 
Συναρτήσεις-Μέλη 

 
void __fastcall TAbout::FormCanResize(TObject *Sender, int &NewWidth, int 

&NewHeight, bool &Resize) 

   Καθορίζει ότι το µέγεθος της φόρµας είναι αµετάβλητο (Resize = false).  

   
   Σηµειώνεται ότι τα Unit1 και Unit3 που αντιστοιχούν στις φόρµες Entry και Initial 

αντίστοιχα, είναι κοινά και για τις δύο εφαρµογές, του SCS και του CCS. Για αυτό 

αναφέρονται µόνο σε αυτό το κεφάλαιο. 
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Ο ΠΗΓΑΙΟΣ ΚΩ∆ΙΚΑΣ ΤΟΥ CCS 

 

 

ΤΕΧΝΙΚΗ ΠΕΡΙΓΡΑΦΗ 

 
   Το κεφάλαιο αυτό περιγράφει την δοµή ενός πιο ρεαλιστικού µοντέλου των 

Classifier Systems για το πρόβληµα του πολυπλέκτη. Για λόγους που αφορούν τον 

χρόνο και την υπολογιστική ισχύ ασχολείται µόνο µε τον πολυπλέκτη 4 σε 1 (64 

δυνατοί συνδυασµοί εισόδων-εξόδων) εφόσον µπορεί εύκολα να επεκταθεί και σε πιο 

πολύπλοκους πολυπλέκτες (π.χ. 8 σε 1). 

   Το πρώτο βήµα είναι ο καθορισµός του πληθυσµού µαζί µε τα χαρακτηριστικά 

κάθε ατόµου που τον αποτελούν. Για τον ορισµό ενός ατόµου χρησιµοποιείται η 

παρακάτω δοµή: 

 
typedef struct               
{ 
   AnsiString condition; 
   AnsiString action; 
   double strength; 
   double bid; 
   bool matchflag; 
}classtype;    
 
   Όπως παρατηρείτε κάθε άτοµο αποτελείται από έναν ανεξάρτητο κανόνα (κι όχι σετ 

κανόνων). Οι πρώτες δύο αλφαριθµητικές µεταβλητές αναφέρονται στο Condition 

και το Action αντίστοιχα του κάθε Classifier. Επίσης υπάρχουν και κάποιες 

µεταβλητές που αναφέρονται στα χαρακτηριστικά του ατόµου. Η µεταβλητή Strength 

αναφέρεται στη δύναµη του και είναι στην ουσία η ποιότητα (fitness). Ακόµη η 

µεταβλητή bid αναφέρεται στην προσφορά που κάνουν τα Classifiers (άτοµα) 

προκειµένου να ενεργοποιηθούν και καθορίζεται από την γραµµική σχέση της 

δύναµης και του συντελεστή προσφοράς (Coefficient Bid). 

BidtCoefficienstrengthbid _×=  

   Τέλος η λογική µεταβλητή matchflag χρησιµεύει για να δηλώσει ποια άτοµα 

ταίριαξαν µε µία είσοδο (true) ή όχι (false). 
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   Και για το πρόγραµµα αυτό χρειάστηκε να οριστούν οι δύο δυναµικοί πίνακες που 

περιλαµβάνουν τις δυνατές εισόδους detc[] και τις αντίστοιχες εξόδούς αυτών out[]. 

   Οι τιµές για κάθε θέση των δύο πινάκων καθορίζονται επίσης από τις συναρτήσεις 

IntToBinary() για τον detc[] και την OutputMsg() για τον out[]. Η ανάλυση των δύο 

αυτών συναρτήσεων καθώς και τα σώµατα του ορισµού τους περιγράφονται στο 

προηγούµενο κεφάλαιο του SCS. 

   Πριν τελειώσουµε µε το Performance System είναι αναγκαίο να περιγραφεί µια 

συνάρτηση µε θεµελιακό ρόλο. Είναι η συνάρτηση match() που εµφανίζεται και στον  

SCS, ασφαλώς τροποποιηµένη για τις ανάγκες του παρόντος προγράµµατος του CCS. 

Κι ενώ πριν η συνάρτηση αυτή χρησίµευε στο να καθορίζει τον αριθµό των  

ταιριασµάτων µεταξύ όλων των δυνατών εισόδων και του κάθε ατόµου (σετ 

κανόνων) που παρήγαγε τη σωστή έξοδο για κάθε είσοδο, πλέον τροποποιείται στο 

να ελέγχει αν ταιριάζει µία µόνο είσοδος µε το κάθε άτοµο/κανόνα του πληθυσµού 

και να επιστρέφει  αληθή ή ψευδή τιµή ανάλογα αν ταιριάζουν ή όχι και η οποία τιµή 

να λαµβάνεται από την µεταβλητή matchflag του κάθε ατόµου. 

   Συνέχεια έχουν τα iterations του BB. Σε κάθε iteration λαµβάνει χώρα η 

δηµοπρασία, η πληρωµή επιταγών και η φορολογία των ατόµων.  

   Για την δηµοπρασία (Auction), υπάρχει µια οµώνυµη υπεύθυνη συνάρτηση. Σ’ 

αυτήν στέλνονται ορίσµατα ο πληθυσµός, µια δυναµική λίστα η clist[] που κρατάει 

τα άτοµα που ταίριαξαν µε µια συγκεκριµένη είσοδο, και ακόµη το πλήθος των 

στοιχείων της clist[]. Εσωτερικά η συνάρτηση αυτή βρίσκει και επιστρέφει την θέση 

του επικρατέστερου ατόµου – άτοµο µε την µεγαλύτερη προσφορά bid-. Στην 

περίπτωση της ισοβαθµίας εισάγεται θόρυβος µε την βοήθεια της συνάρτησης 

noise(), µέσω του οποίου διαφοροποιούνται τα ισοδύναµα άτοµα και µπορούµε έτσι 

να  επιλέξουµε το επικρατέστερο. Σώµα συνάρτησης της Auction(): 

 
double noise(double bidN) 
{ 
    bidN+= bidN * (rnd()*(0.02*noiseP)-(0.01*noiseP)); 
    return bidN;  
} 
 
int Auction(classtype par[], int cl[], int N) 
{ 
   int p,i,best; 
   double max; 
   double * temp; 
   temp=new double[N]; 
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   for(i=0;i<N;i++) 
   { 
      p=cl[i];    
      temp[i]=noise(par[p].bid); 
   } 
   max=temp[0]; 
   best=0; 
   for(i=1;i<N;i++) 
   { 
      if(max<temp[i]) 
      { 
         max=temp[i]; 
         best=i; 
      } 
   } 
   delete(temp); 
   return cl[best]; 
} 
 

   Για την πληρωµή Επιταγών λαµβάνεται το άτοµο νικητής της προηγούµενης 

διαδικασίας και του αφαιρείται το ποσό bid που πρόσφερε για την ενεργοποίηση του. 

Υπεύθυνη για αυτό είναι η Payment() που καλείται µέσα από την ευρύτερη 

συνάρτηση ClearingHouse(). Αν τύχει και το µήνυµα αυτού του ατόµου είναι σωστό 

τότε υπάρχει επιβράβευση γι’ αυτό το άτοµο που του δίνεται µέσα από την 

συνάρτηση Reward(). Παρακάτω φαίνονται τα σώµατα αυτών των συναρτήσεων: 

 

classtype ClearingHouse(classtype p1,int ROutput) 
{ 
   p1=Payment(p1); 
   p1.strength=Reward(p1,ROutput); 
   return p1; 
} 
  

classtype Payment(classtype p2) 
{ 
   p2.strength=p2.strength-p2.bid;     //new strength definition 
   p2.bid=p2.strength*CBID;            //new bid definition 
   return p2; 
}   
 
double Reward(classtype p2, int ROutput) 
{ 
    if(p2.action==ROutput)          //if right output is equal to action give a reward 
   { 
      p2.strength=p2.strength+REWARDBID; 
      p2.bid=p2.strength*CBID; 
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    } 
    return p2.strength; 
} 
 
   Η είσπραξη φόρων τώρα είναι µια διαδικασία που αποτρέπει την ανεξέλεγκτη 

αύξηση της δύναµης των κανόνων µέσα από δύο είδη φόρων που επιβάλλονται στα 

άτοµα. Το πρώτο είδος εφαρµόζεται και λαµβάνεται από όλα τα άτοµα και 

καθορίζεται από την πραγµατική µεταβλητή LIFETAX. Το δεύτερο είδος 

εφαρµόζεται µόνο στα άτοµα που έκαναν Bid και καθορίζεται από την πραγµατική 

µεταβλητή BIDTAX. Αν και τα δύο αυτά µεγέθη είναι διάφορα του µηδενός, υπάρχει 

κατάλληλος µηχανισµός µέσα στο σώµα της συνάρτησης µε το οποίο εισπράττετε το 

κατάλληλο ποσό φόρου από κάθε άτοµο. 

 

classtype TaxCollector(classtype p1) 
{ 
   int bidtaxswitch; 
 
   if(p1.matchflag) bidtaxswitch=1; 
   else                    bidtaxswitch=0; 
   p1.strength= p1.strength – LIFETAX*p1.strength – BIDTAX*bidtaxswitch*  
                        p1.strength;    
   p1.bid=p1.strength*CBID; 
   return p1; 
}    
 

   Εδώ τελειώνει ο αλγόριθµος του BB και στο προσκήνιο ανεβαίνει µια άλλη 

σηµαντική διεργασία, ο Γενετικός Αλγόριθµος. Είναι ελαφρώς τροποποιηµένος από 

το προηγούµενο µοντέλο του SCS, µιας και τα άτοµα δεν αποτελούνται όπως έχει 

ήδη αναφερθεί από σετ κανόνων αλλά από ξεχωριστά ανεξάρτητα Classifiers. Και γι’ 

αυτήν την εργασία χρησιµοποιήθηκαν οι ίδιες ή παραλλαγές των διαδικασιών 

επιλογής, αποτίµησης, ανασυνδυασµού και αντικατάστασης.  

   Για την επιλογή χρησιµοποιήθηκε και πάλι η µέθοδος Roulette Wheel 

τροποποιηµένη για έναν κανόνα κι όχι για έναν πίνακα από αυτούς. Η συνάρτηση που 

της αντιστοιχεί είναι η RouletteWheel().  

   Ακολουθεί ο τελεστής διασταύρωσης που κι εδώ µαζί µε τον τελεστή µετάλλαξης 

λειτουργούν πιθανοκρατικά. Χρησιµοποιήθηκε διασταύρωση ενός σηµείου (βλ. ΓΑ-

Τελεστής ∆ιασταύρωσης). Εδώ όπως παρατηρεί κανείς κι από την συνάρτηση, τα δύο 

άτοµα που επιλέχθηκαν ανασυνδυάζονται βάση ενός σηµείου κοπής. Ακόµη για το 

παραγόµενο άτοµο καθορίζονται εσωτερικά της συνάρτησης και τα βάρη της 
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δύναµης και της προσφοράς. Η δύναµη προκύπτει ως ο µέσος όρος των δυνάµεων 

των δύο γονέων και η προσφορά από την γνωστή γραµµική σχέση της µε την δύναµη.    

   O τελεστής µετάλλαξης του CCS λειτουργεί παρόµοια µε αυτόν του SCS αν στη 

θέση του ενιαίου γονότυπου που αποτελείται από N κανόνες βάλουµε µόνο έναν.  

   Η αντικατάσταση σταθερής κατάστασης υλοποιείται µε έναν βρόχο for() που τρέχει 

τόσες φορές όσες και τα άτοµα που θέλουµε να αντικαταστήσουµε. 

   Η εφαρµογή τερµατίζει µόλις ικανοποιηθεί το κριτήριο του κύριο βρόχου που είναι 

µια επαναληπτική µέθοδος do..while{}. Ο βρόχος αυτός περιλαµβάνει τον ΒΒ και τον 

ΓΑ. Μόλις ολοκληρωθούν τα συνολικά iterations τερµατίζει. 

 

 

 

ΤΑ UNIT ΤΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ 
 
 
 
ΦΟΡΜΑ TOY SCS 
 

   Είναι η κύρια φόρµα του προγράµµατος που προσοµοιώνει την συνάρτηση εισόδου 

εξόδου του σύνθετου ψηφιακού πολυπλέκτη µε την χρήση του «Συστήµατος 

Καταµερισµού Βαθµών». 

  

   Η φόρµα αυτή αντιστοιχεί στο Unit4 και αποτελείται από τα εξής αρχεία:   

• Unit4.cpp 

• Unit4.h 

• Unit4.dfm 

 

Κλάση 

 

TCCSMainForm: Η κλάση της κύριας φόρµας. 

Σταθερές  

 
#define ABITS 1: Σταθερά για τον καθορισµό του µήκους του µηνύµατος. 

#define LIFETAX 0.0 : Σταθερά για την φορολογία όλων των κανόνων.     

#define BIDTAX 0.01 : Σταθερά για την φορολογία µόνο των κανόνων που    
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                                       ταίριαξαν µε την είσοδο.    

#define address 2 : Σταθερά που δηλώνει το µέγεθος του Address των Classifiers. 

 

Μεταβλητές και ∆οµές 

 
typedef struct 
{ 
   AnsiString condition; 
   AnsiString action; 
   double strength; 
   double bid; 
   bool matchflag; 
}classtype;      
 
   ∆οµή τύπου classtype.  

 
int P :  

   Μεταβλητή που ορίζεται από τον χρήστη και δηλώνει το πλήθος του Classifier 

Store 

double CROSSPROB : 

   Ορίζεται από τον χρήστη και δηλώνει την πιθανότητα διασταύρωσης. 

double PMUT :  

   Ορίζεται από τον χρήστη και δηλώνει την πιθανότητα µετάλλαξης. 

double CBID :  

   Ορίζεται από τον χρήστη και δηλώνει τον Συντελεστή Προσφοράς. 

int REWARDBID : 

   Ορίζεται από τον χρήστη και δηλώνει την επιβράβευση.  

int iteration :  

   ∆ηλώνει τον αριθµό των iterations σε κάθε εκτέλεση του ΒΒ. Το total iteration 

ορίζει πόσα τέτοια iterations θα έχουµε. 

int TotalIteration : 

   Ορίζεται από τον χρήστη και δηλώνει τα συνολικά iterations. Η τιµή που εισάγεται 

πολλαπλασιάζετε µε την µεταβλητή iteration. 

int offspringN : 

   ∆ηλώνει τον αριθµό των απογόνων που δηµιουργούνται σε κάθε εκτέλεση του ΓΑ. 

Ορίζεται από τον χρήστη.  

int noiseP : 
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   ∆ηλώνει το ποσοστό του θορύβου που χρησιµοποιείται για τον ασαφή 

προσδιορισµό του επικρατέστερου κανόνα από ένα σύνολο ισοδύναµων κανόνων. 

Ορίζεται από τον χρήστη. 

int data :  

   Μεταβλητή που δηλώνει το µέγεθος του data των κανόνων. Εξαρτάται από                 

το address. 

int BITS :  

   Μέγεθος του Condition. Εξαρτάται από τα address και data. 

int T :  

   Πλήθος δυνατών συνδυασµών εισόδου-εξόδου. Εξαρτάται από το BITS. 

 

Συναρτήσεις 

 

double rnd(void) 

   Παράγει έναν τυχαίο αριθµό στο διάστηµα [0,1]. 

 
AnsiString IntToBinary(int x) 

   Παίρνει σαν όρισµα έναν αριθµό µεταξύ του ‘0’ και του µέγιστου των δυνατών 

συνδυασµών εισόδων-εξόδων και επιστρέφει την δυαδική του µορφή. 

 
Int OutputMsg(AnsiString str)    

   Παίρνει σαν όρισµα την δυαδική µορφή µιας εισόδου και επιστρέφει την σωστή 

έξοδο για αυτήν την είσοδο. 

 
void match(classtype *par1,AnsiString str) 

   Ταιριάζει µία είσοδο µε έναν κανόνα. Επιστρέφει true ή false ανάλογα µε το αν 

ταιριάζουν ή όχι αντίστοιχα. 

 
classtype TaxCollector(classtype p1) 

   Η συνάρτηση αυτή αποδίδει φόρους στα άτοµα. 

 
int Auction(classtype par[], int cl[], int N) 

   Η συνάρτηση δηµοπρασίας. Επιστρέφει την θέση του ατόµου που έκανε την 

µεγαλύτερη προσφορά.    
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int noise(double bidN) 

   Η συνάρτηση αυτή προσθέτει θόρυβο στις τιµές bid των ατόµων χωρίς να 

αποθηκεύεται µε σκοπό να αναδείξει µε µια ελαφριά ασάφεια το ποιος από τους 

κανόνες κερδίζει κάθε φορά. 

     
classtype ClearingHouse(classtype p1, int ROutput) 

   Συνάρτηση πληρωµής Επιταγών. 

 
Classtype Payment(classtype p2) 

   Η συνάρτηση αυτή αφαιρεί το ποσό της προσφοράς από το ενεργοποιηµένο άτοµο. 

 
double Reward(classtype p2,int ROutput) 

   Αν η έξοδος του ενεργοποιηµένου ατόµου είναι σωστή, τότε η συνάρτηση αυτή 

επιβραβεύει το συγκεκριµένο άτοµο. 

 
int roulettewheel(classtype par1[]) 

   Συνάρτηση επιλογής γονέων βάση της ποιότητας/δύναµης.  

 
classtype Crossover1Point(classtype s1, classtype s2) 

   Συνάρτηση διασταύρωσης ενός σηµείου. 

 
classtype Mutation(classtype p)    

   Συνάρτηση µετάλλαξης ατόµων. 

 
int Success(classtype * par, AnsiString * detc) 

   Συνάρτηση επιτυχίας. Εισάγοντας όλες τις δυνατές εισόδους στο σύστηµα 

συγκρίνει και επιστρέφει πόσες από αυτές ταιριάζουν µε τους κανόνες προκαλώντας 

σωστά µηνύµατα. 

 
 
Συναρτήσεις-Μέλη 

 

void __fastcall TCCSMainForm::RunButtonClick(TObject *Sender) 

   Είναι η βασική συνάρτηση µέσα στην οποία γίνονται όλες οι διεργασίες: 

 ∆ηµιουργία δυναµικού πληθυσµού γονέων: 

      classif * par; 
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      par=new classif[P]; 

       
 ∆ηµιουργία δυναµικών πινάκων για τις εισόδους – εξόδους 

      int* out; 

      out=new int[T]; 

      AnsiString* detc; 

      detc=new AnsiString[T]; 

  

   Κλήσεις όλων των παραπάνω συναρτήσεων που είναι υπεύθυνες για την γενετική 

εξέλιξη των ατόµων καθώς και κάποιων βοηθητικών συναρτήσεων (π.χ. rnd() , 

IntToBinary(), …). 

 
void __fastcall TCCSMainForm::FormClose(TObject *Sender, 
TCloseAction &Action) 

   Τερµατίζει την εφαρµογή. 

 
void __fastcall TCCSMainForm::QuitCClick(TObject *Sender) 

  Όµοια µε την προηγούµενη 

 
void __fastcall TCCSMainForm::About1Click(TObject *Sender) 

   Εµφανίζει την φόρµα About. 

 
void __fastcall TCCSMainForm::StopCClick(TObject *Sender) 

   Σταµατάει την διαδικασία σε όποιο σηµείο της εκτέλεσης θέλουµε. 

 
void __fastcall TCCSMainForm::DefaultSizeForm1Click(TObject *Sender) 

   Επανακαθορίζει την φόρµα στο αρχικό της µέγεθος. 

 
void __fastcall TCCSMainForm::RootMenu1Click(TObject *Sender) 

   Επιστρέφει στην εισαγωγική φόρµα. 

 
void __fastcall TCCSMainForm::FormCanResize(TObject *Sender, int 

&NewWidth, int &NewHeight, bool &Resize) 

   Ελέγχει τα όρια της φόρµας να µην ξεπεράσουν τα επιθυµητά. 

 
void __fastcall TCCSMainForm::Parameters1Click(TObject *Sender) 
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   Εµφανίζει την φόρµα αρχικοποίησης των µεγεθών. 

 

 

ΦΟΡΜΑ ΑΡΧΙΚΟΠΟΙΗΣΗΣ ΤΙΜΩΝ INITIAL 
 
 
 
   Είναι µία Modal φόρµα που εµφανίζεται για να εισάγουµε τα αρχικά στοιχεία. 

Αποτελείται από 9 Edit Boxes , 9 Labels και 2 BitBtns. 

 
Η φόρµα αυτή αντιστοιχεί στο Unit6 και αποτελείται από τα εξής αρχεία:   

• Unit6.cpp 

• Unit6.h 

• Unit6.dfm 

Κλάση 

 
TInitial_CCS: Η κλάση της φόρµας. 
 
 
Συναρτήσεις-Μέλη 
 
 
void __fastcall TInitial_CCS::FormCreate(TObject *Sender) 

   Καλείται µε το που δηµιουργείται η φόρµα. Χρησιµεύει στο να καθορίζει τις 

αρχικές τιµές των µεγεθών. Ο χρήστης βέβαια µπορεί να τις αλλάξει ανά πάσα 

στιγµή. 

 
void __fastcall TInitial_CCS::FormCanResize(TObject *Sender, int 

&NewWidth, int &NewHeight, bool &Resize) 

   Καθορίζει ότι το µέγεθος της φόρµας είναι αµετάβλητο (Resize = false). 

 
void __fastcall TInitial_CCS::popEditKeyPress(TObject *Sender, char &Key)    

   Καλείται όταν εισάγουµε τα δεδοµένα στο popEdit Box και ελέγχει αν έχουν δοθεί 

σωστά. Αν για παράδειγµα πατηθεί χαρακτήρας αντί αριθµού τότε εµφανίζεται 

αντίστοιχο µήνυµα που µας ειδοποιεί ότι πρέπει να επανακαθορίσουµε την τιµή του 

στοιχείου. 

 
void __fastcall TInitial_CCS::total_iterationEditKeyPress(TObject *Sender, 

 -81- 



Ρόµπης Κωνσταντίνος Πτυχιακή Εργασία  Περιεχόµενα                   

char &Key) 

   Όµοια κι εδώ ελέγχεται τι πατήθηκε µέσα στο total_iterationEdit Box και 

αντίστοιχα είτε εκχωρεί την τιµή στο στοιχείο είτε εµφανίζει µήνυµα για τον 

επανακαθορισµό του µεγέθους. 

 
void __fastcall TInitial_CCS:: iterationEditKeyPress(TObject *Sender, 

char &Key) 
   Όµοια κι εδώ ελέγχεται τι πατήθηκε µέσα στο iterationEdit Box και αντίστοιχα είτε 

εκχωρεί την τιµή στο στοιχείο είτε εµφανίζει µήνυµα για τον επανακαθορισµό του 

µεγέθους. 

 
void __fastcall TInitial_CCS::rewardEditKeyPress(TObject *Sender, 

char &Key) 

   Όµοια κι εδώ ελέγχεται τι πατήθηκε µέσα στο rewardEdit Box και αντίστοιχα είτε 

εκχωρεί την τιµή στο στοιχείο είτε εµφανίζει µήνυµα για τον επανακαθορισµό του 

µεγέθους. 

 
void __fastcall TInitial_CCS::offspringNumberEditKeyPress(TObject *Sender, 
char &Key) 

   Όµοια κι εδώ ελέγχεται τι πατήθηκε µέσα στο offspringNumberEdit Box και 

αντίστοιχα είτε εκχωρεί την τιµή στο στοιχείο είτε εµφανίζει µήνυµα για τον 

επανακαθορισµό του µεγέθους. 

 
void __fastcall TInitial_CCS::noiseEditKeyPress(TObject *Sender, char &Key) 

   Όµοια κι εδώ ελέγχεται τι πατήθηκε µέσα στο noiseEdit Box και αντίστοιχα είτε 

εκχωρεί την τιµή στο στοιχείο είτε εµφανίζει µήνυµα για τον επανακαθορισµό του 

µεγέθους. 

   Οι έξι αυτές παράµετροι λαµβάνουν µόνο ακέραιους αριθµούς. Έτσι αν πατηθεί 

ακόµη και ο χαρακτήρας ‘,’ εµφανίζεται πάλι το µήνυµα λάθους. 

 
void __fastcall TInitial_CCS::crosspEditKeyPress(TObject *Sender, char &Key) 

   Όµοια ελέγχεται τι πληκτρολόγησε ο χρήστης του προγράµµατος για την 

πιθανότητα ∆ιασταύρωσης. Ο χρήστης µπορεί να πληκτρολογήσει και πραγµατικό 

αριθµό. Επίσης ελέγχει αν αντί του χαρακτήρα  ‘,’  που είναι για τους δεκαδικούς 

πατηθεί ο χαρακτήρας ‘.’ και αλλάζει αυτόµατα στον ‘,’ . 

void __fastcall TInitial_CCS::mutpEditKeyPress(TObject *Sender, char &Key) 
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   Όµοια ελέγχεται τι πληκτρολόγησε ο χρήστης του προγράµµατος για την 

πιθανότητα µετάλλαξης. Ο χρήστης µπορεί να πληκτρολογήσει και πραγµατικό 

αριθµό. Επίσης ελέγχει αν αντί του χαρακτήρα  ‘,’  που είναι για τους δεκαδικούς 

πατηθεί ο χαρακτήρας ‘.’ και αλλάζει αυτόµατα στον ‘,’ . 

 

void __fastcall TInitial_CCS::cbidEditKeyPress(TObject *Sender, char &Key) 

   Όµοια ελέγχεται τι πληκτρολόγησε ο χρήστης του προγράµµατος για τον 

συντελεστή προσφοράς. Ο χρήστης µπορεί να πληκτρολογήσει και πραγµατικό 

αριθµό. Επίσης ελέγχει αν αντί του χαρακτήρα  ‘,’  που είναι για τους δεκαδικούς 

πατηθεί ο χαρακτήρας ‘.’ και αλλάζει αυτόµατα στον ‘,’ . 

 
 
 
ΦΟΡΜΑ ΑΡΧΙΚΟΠΟΙΗΣΗΣ ΦΟΡΩΝ  
 
 
 
   Είναι µία Modal φόρµα που εµφανίζεται για να εισάγουµε τα αρχικά στοιχεία. 

Αποτελείται από 2 Edit Boxes , 2 Labels και 2 BitBtns. 

 
Η φόρµα αυτή αντιστοιχεί στο Unit7 και αποτελείται από τα εξής αρχεία:   

• Unit7.cpp 

• Unit7.h 

• Unit7.dfm 

Κλάση 

 
TTaxes: Η κλάση της φόρµας. 
 
 
Συναρτήσεις-Μέλη 
 
 
void __fastcall TTaxes::FormCanResize(TObject *Sender, int &NewWidth, 

int &NewHeight, bool &Resize) 

   Καθορίζει ότι το µέγεθος της φόρµας είναι αµετάβλητο (Resize = false).    

 
void __fastcall TTaxes::FormCreate(TObject *Sender) 
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   Καλείται µε το που δηµιουργείται η φόρµα. Χρησιµεύει στο να καθορίζει τις 

αρχικές τιµές των µεγεθών. Ο χρήστης βέβαια µπορεί να τις αλλάξει ανά πάσα 

στιγµή. 

 
void __fastcall TTaxes::lifetaxEditKeyPress(TObject *Sender, char &Key) 

   Ελέγχεται τι πληκτρολόγησε ο χρήστης του προγράµµατος για την παράµετρο αυτή. 

Ο χρήστης µπορεί να πληκτρολογήσει και πραγµατικό αριθµό. Επίσης ελέγχει αν αντί 

του χαρακτήρα  ‘,’  που είναι για τους δεκαδικούς πατηθεί ο χαρακτήρας ‘.’ και 

αλλάζει αυτόµατα στον ‘,’ . 

 
void __fastcall TTaxes::bidtaxEditKeyPress(TObject *Sender, char &Key) 

   Όµοια µε την παραπάνω για το BIDTAX. 

 

   Το πρόγραµµα επίσης “βλέπει” και την εισαγωγική φόρµα καθώς και την φόρµα 

About, οι οποίες ήδη αναφέρθηκαν στο προηγούµενο πρόγραµµα και για αυτό δεν 

υπάρχει λόγος να αναλυθούν στο σηµείο αυτό. 
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ΠΗΓΑΙΟΣ ΚΩ∆ΙΚΑΣ 

ΠΡΟΓΡΑΜΜΑΤΟΣ
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